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Preface

INTRODUCTION

This user’s guide supports the dsPICDEM.net 1 and dsPICDEM.net 2 connectivity
development boards. These boards provide basic platforms that enable the application
developer to create and evaluate both connectivity and non-connectivity based
solutions. This chapter previews the contents of the manual, tells you how to obtain
valuable customer support and recommends useful reference information.

HIGHLIGHTS

Items discussed in this chapter are:

+ About This Guide

» Warranty Registration

* Recommended Reading

* The Microchip Web Site

» Development Systems Customer Notification Service
» Customer Support

ABOUT THIS GUIDE

This user’s guide describes how to use the dsPICDEM.net 1 and dsPICDEM.net 2
connectivity development boards. The document is organized as follows:

» Chapter 1: Introduction — This chapter introduces the dsPICDEM.net 1 and
dsPICDEM.net 2 connectivity development board and provides a brief description
of the hardware.

» Chapter 2: Tutorial — This chapter presents a step-by-step process for getting
your dsPICDEM.net 1 and dsPICDEM.net 2 connectivity development board up
and running with the MPLAB® In-Circuit Debugger 2 (MPLAB ICD 2).

» Chapter 3: Quick Start Program — This chapter describes the operational func-
tionality of a demonstration program included on the dsPICDEM.net Development
Kit Software CD. The demonstration program exercises several capabilities of the
dsPIC30F by interacting with peripheral devices on the development board.

» Chapter 4: HTTP Web Server Demonstration — This chapter describes the
operational functionality of a sample HTTP Web Server based embedded
application that is included on the dsPICDEM.net Development Kit Software CD.

» Chapter 5: FTP Server Demonstration — This chapter describes the operational
functionality of a sample FTP Server based embedded application that is included
on the dsPICDEM.net Development Kit Software CD.

» Chapter 6: V.22bis Soft Modem Demonstration — This chapter describes the
operational functionality of a sample PSTN based application that is
preprogrammed into the dsPIC30F6014 device.

» Chapter 7: dsPICDEM.net™ Development Hardware — This chapter describes
the hardware included on the of the dsPICDEM.net 1 and dsPICDEM.net 2
boards.

» Appendix A: Hardware Schematics — This Appendix contains hardware layout
and schematic diagrams of the dsPICDEM.net 1 and dsPICDEM.net 2.

© 2004 Microchip Technology Inc. DS51471A-page 1
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Conventions Used in This Guide

This User's Guide uses the following documentation conventions:

DOCUMENTATION CONVENTION

Description Represents Examples
Code (Courier font):
Plain characters Sample code #define START
Filenames and paths c:\autoexec.bat
Angle brackets: < > Variables <labels>, <exp>
Square brackets [ ] Optional arguments pic30-as [main.s]
Curly brackets and pipe | Choice of mutually exclusive errorlevel {01}
character: {| } arguments; an OR selection
Lower case characters | Type of data "£i1ename"
in quotes
Ellipses... Used to imply (but not show) list
additional text that is not relevant to ["list option...,
the example "1ist option"]
Oxnnn A hexadecimal number where n is a 0XFFFF, O0x007A
hexadecimal digit
Italic characters A variable argument; it can be either a | char isascii (char,

type of data (in lower case characters) | ch) ;
or a specific example (in upper case

characters)
Interface (Arial font):
Underlined, italic text A menu selection from the menu bar | File > Save
with right arrow
Bold characters A window or dialog button to click OK, Cancel
Characters in angle A key on the keyboard <Tab>, <Ctrl-C>
brackets < >
Documents (Arial font):
Italic characters | Referenced books | MPLAB IDE User’s Guide

Documentation Updates

All documentation becomes dated, and this user’s guide is no exception. Since
Microchip tools are constantly evolving to meet customer needs, some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web
site to obtain the latest documentation available.

Documentation Numbering Conventions

Documents are numbered with a “DS” number. The number is located on the bottom of
each page, in front of the page number. The numbering convention for the DS Number
is DSXXXXXA, where:

XXXXX = The document number.
A =  The revision level of the document.
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly.
Sending in your Warranty Registration Card entitles you to receive new product
updates. Interim software releases are available at the Microchip web site.

DS51471A-page 2 © 2004 Microchip Technology Inc.
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RECOMMENDED READING

This user’s guide describes how to use the dsPICDEM.net 1 and dsPICDEM.net 2
Connectivity Development Board. Other useful documents include:

dsPIC30F Family Reference Manual (DS70046)

Consult this document for detailed information on dsPIC30F device operation. This
reference manual explains the operation of the dsPIC30F MCU family architecture and
peripheral modules but does not cover the specifics of each device. Refer to the
appropriate device data sheet for device-specific information.

dsPIC30F Data Sheet, Motor Control and Power Conversion Family (DS70082)

Consult this document for detailed information on the dsPIC30F Motor Control and
Power Conversion devices. Reference information found in this data sheet includes:
* Device memory map

» Device pinout and packaging details

 Device electrical specifications

* List of peripherals included on the device

dsPIC30F Data Sheet, General Purpose and Sensor Families (DS70083)

Consult this document for detailed information on the dsPIC30F Sensor and General
Purpose devices. Reference information found in this data sheet includes:

» Device memory map

 Device pinout and packaging details

* Device electrical specifications

+ List of peripherals included on the device

dsPIC30F5011, dsPIC30F5013 Data Sheet, High Performance Digital Signal
Controllers (DS70116)

This data sheet contains specific information for the dsPIC30F5011/5013 Digital Signal
Controller (DSC) devices.

dsPIC30F6011, dsPIC30F6012, dsPIC30F6013, dsPIC30F6014 Data Sheet, High
Performance Digital Signal Controllers (DS70117)

This data sheet contains specific information for the dsPIC30F6011/6012/6013/6014
Digital Signal Controller (DSC) devices.

dsPIC30F Programmer’s Reference Manual (DS70030)

This manual is a software developer’s reference for the dsPIC30F 16-bit MCU family
of devices. This manual describes the instruction set in detail and also provides general
information to assist you in developing software for the dsPIC30F MCU family.

dsPIC30F Family Overview (DS70043)

This document provides an overview of the functionality of the dsPIC® product family.
It helps determine how the dsPIC30F 16-bit Digital Signal Controller Family fits a
specific product application. This document is a supplement to the dsPIC30F Family
Reference Manual.

MPLAB® ASM30, MPLAB® LINK30 and Utilities User's Guide (DS51317)

This document helps you use Microchip Technology’s language tools for dsPIC devices
based on GNU technology. The language tools discussed are:

* MPLAB ASM30 Assembler

* MPLAB LINK30 Linker

* MPLAB LIB30 Archiver/Librarian

» Other Utilities

© 2004 Microchip Technology Inc. DS51471A-page 3
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MPLAB C30 C Compiler User’s Guide (DS51284)

This document details the use of Microchip’s MPLAB C30 C Compiler for dsPIC
devices to develop an application. MPLAB C30 is a GNU-based language tool, based
on source code from the Free Software Foundation (FSF). For more information about
the FSF, see www.fsf.org.

Other GNU language tools available from Microchip are:

+ MPLAB ASM30 Assembler

» MPLAB LINK30 Linker

» MPLAB LIB30 Librarian/Archiver

dsPIC™ Language Tools Libraries (DS51456)

DSP, dsPIC peripheral and standard (including math) libraries for use with dsPIC
language tools.

GNU HTML Documentation

This documentation is provided on the language tool CD-ROM. It describes the
standard GNU development tools, upon which these tools are based.

MPLAB® IDE Simulator, Editor User’s Guide (DS51025)

Consult this document for more information pertaining to the installation and
implementation of the MPLAB Integrated Development Environment (IDE) Software.

To obtain any of these documents, visit the Microchip web site at www.microchip.com.

THE MICROCHIP WEB SITE

Microchip provides online support on the Microchip World Wide Web (WWW) site. The
web site is used by Microchip as a means to make files and information easily available
to customers. To view the site, you must have access to the Internet and a web
browser, such as, Netscape® Navigator or Microsoft® Internet Explorer. The Microchip
web site is available at:www.microchip.com.

The web site provides a variety of services. Users may download files for the latest
development tools, data sheets, application notes, user's guides, articles and sample
programs. A variety of information specific to the business of Microchip is also
available, including listings of Microchip sales offices, distributors and factory
representatives.

Technical Support
» Frequently Asked Questions (FAQ)

» Online Discussion Groups — conferences for products, development systems,
technical information and more

* Microchip Consultant Program Member Listing
* Links to other useful web sites related to Microchip products

Engineer’s Toolbox
» Design Tips
+ Device Errata

Other Available Information

+ Latest Microchip Press Releases
+ Listing of Seminars and Events

» Job Postings

DS51471A-page 4
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DEVELOPMENT SYSTEMS CUSTOMER NOTIFICATION SERVICE

Microchip started the customer notification service to help our customers stay current
on Microchip products with the least amount of effort. Once you subscribe, you will
receive E-mail notification whenever we change, update, revise or have errata related
to your specified product family or development tool of interest.

Go to the Microchip web site at (www.microchip.com) and click on Customer Change
Notification. Follow the instructions to register.

The Development Systems product group categories are:
» Compilers

* Emulators

* In-Circuit Debuggers

- MPLAB

* Programmers

Here is a description of these categories:

Compilers — The latest information on Microchip C compilers and other language
tools. These include the MPLAB C17, MPLAB C18 and MPLAB C30 C compilers;
MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object
linkers; MPLIB™ and MPLAB LIB30 object librarians.

Emulators — The latest information on Microchip in-circuit emulators. This includes the
MPLAB ICE 2000 and MPLAB ICE 4000.

In-Circuit Debuggers — The latest information on Microchip in-circuit debuggers.
These include the MPLAB ICD and MPLAB ICD 2.

MPLAB - The latest information on Microchip MPLAB IDE, the Windows Integrated
Development Environment for development systems tools. This list is focused on the
MPLAB IDE, MPLAB SIM and MPLAB SIM30 simulators, MPLAB IDE Project Manager
and general editing and debugging features.

Programmers — The latest information on Microchip device programmers. These
include the PRO MATE® Il device programmer and PICSTART® Plus development
programmer.

© 2004 Microchip Technology Inc. DS51471A-page 5
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)

» Corporate Applications Engineer (CAE)

* Hotline

Customers should call their distributor, representative or field application engineer

(FAE) for support. Local sales offices are also available to help customers. See the
sales offices and locations listed on the back of this publication.

Corporate Applications Engineers (CAEs) may be contacted at (480) 792-7627.

In addition, there is a Systems Information and Upgrade Line. This line provides system
users a listing of the latest versions of all of Microchip's development systems software
products. Plus, this line provides information on how customers can receive any
currently available upgrade Kits.

The Hotline Numbers are:
1-800-755-2345 for U.S. and most of Canada.
1-480-792-7302 for the rest of the world.

DS51471A-page 6
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Chapter 1. Introduction

1.1 INTRODUCTION

This chapter introduces several connectivity capabilities that can easily be
implemented with the use of the dsPICDEM.net Connectivity Development Board.

1.2  HIGHLIGHTS

This chapter discusses:

» Overview

» dsPICDEM.net Package Contents

» dsPICDEM.net Board Functionality

» dsPICDEM.net Demonstration Programs
» Reference Documents

1.3 OVERVIEW

The dsPICDEM.net 1 and dsPICDEM.net 2 connectivity development boards are tools
designed to help the application developer create and evaluate both connectivity and
non-connectivity based solutions using dsPIC30F High Performance Digital Signal
Controllers. The dsPICDEM.net 1 board supports the Federal Communications
Commission (FCC) and Japan Approval Institute for Telecommunications Equipment
(JATE) country specific Public Switched Telephone Network (PSTN). The
dsPICDEM.net 2 board supports the Common Technical Regulation 21 (CTR-21)
PSTN. Both boards support the Realtek 10-base T Ethernet Network Interface
Controller (NIC).

Every country has telecommunication laws that prohibit the connection of unapproved
telecommunication devices, including modems, to the phone line. Approval by a
country's telecommunications regulatory agency may entail hardware/firmware
modifications to your end-system modem in order to comply with their
telecommunication laws relative to radio-frequency interference, pulse dial make/break
ratios, redial capabilities, etc.

The words “approved or compliant for use in country XYZ” mean that the modem has
been modified to comply with the telecommunication laws of that country. Thus, a
modem approved by the FCC to work in the USA, for example, is not automatically
approved by the BZT to work in Germany.

Note: Forthe sample applications described in this manual, connect to an analog
line only. You could damage the modem if you use a non-analog line
(e.g., digital or PBX multiline).

© 2004 Microchip Technology Inc. DS51471A-page 7
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The boards come with an ITU-T compliant V.22bis/V.22 modem module and
demonstration code pre-programmed on the installed dsPIC30F6014 device. This
sample application lets you to connect and transfer data between the dsPIC30F Soft
Modem and an ITU-T compliant reference modem. Application source code is included
on the supplied development kit software CD.

The Development Kit Software CD also includes additional sample applications, a
tutorial module and complete product documentation. The additional sample
applications will familiarize you with the CMX-MicroNet HTTP Web and FTP Servers,
which demonstrate two TCP/IP protocol based applications over the 10-Base T
Ethernet Datalink layer. Product tutorials provide hands-on experience in debugging
with the MPLAB ICD 2.

1.4 dsPICDEM.net PACKAGE CONTENTS

The following items comprise the dsPICDEM.net Connectivity Development Board

package:

* The dsPICDEM.net 1 or dsPICDEM.net 2 Printed Circuit Board (supports both
embedded internet and ethernet connections).

» A pre-programmed dsPIC30F6014 device on an adapter board that plugs into the
main development board

» A CAT5 “crossover” network cable (RJ45 connectors) for networking the board.
* 9 VDC Power Supply
* RS-232 Interface Cable

» dsPICDEM.net Development Kit Software CD containing demonstration
connectivity solutions from Microchip and it’s partners along with a product tutorial
and complete documentation.

1.5 dsPICDEM.net BOARD FUNCTIONALITY

The dsPICDEM.net Development Board (Figure 1-1) provides a basic platform for
developing and evaluating solutions that use dsPIC30F6014 16-bit Digital Signal
Controllers. The dsPICDEM.net Development Board includes the following
capabilities:

Power Supply

+ Single on-board +5V regulator for VDD and AVDD with direct input from 9V, AC/DC
wall adapter

» 9 VDC power source input jack for development board

» Power-on indicator LED

MPLAB ICD 2 and ICE 4000 Connections

» MPLAB ICD 2 programming connector
» Emulation header connection to MPLAB ICE 4000
* Pad location for 80-pin TQFP dsPIC device

Serial Communication Channels

+ Single RS-232 communication channel

 6-pin terminal block and configuration jumper for RS-485 and RS-422
communication on UART1 from the dsPIC device

+ Single CAN communication channel

DS51471A-page 8 © 2004 Microchip Technology Inc.
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Public-Switched Telephone Network (PSTN)

+ Silicon Laboratories Si3035 DAA/AFE chipset (dsPICDEM.net 1 board)
+ Silicon Laboratories Si3034 DAA/AFE chipset (dsPICDEM.net 2 board)
» Speaker for monitoring call progress

» Si3021 reset push button switch

FIGURE 1-1: dsPICDEM.net DEVELOPMENT BOARD

10-BaseT Ethernet

» Realtek RTL8019AS 10-Base T single-chip Network Interface Controller and
transceiver

* Four link status LEDs
* RJ-45 (10-Base T) modular connector

Analog

» Two 5 kQ Potentiometers (RP1 and RP2)

» Microchip MCP42050 Digital Potentiometer (dual-channel output)

» Microchip TC1047A Thermal Sensor (U2)

» Microchip MCP602 op amp configured as low-pass filter for thermal sensor (U12)

Device Clocking

» 7.3728 MHz crystal, X3, for dsPIC device

» Socket U16, clock oscillator for dsPIC device (alternate clock source, X3
removed)

» Pad for 32.768 kHz crystal (XTAL2) and load caps

© 2004 Microchip Technology Inc. DS51471A-page 9
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Miscellaneous

Reset push button switch

Three red LEDs (LED1-LED3)

Three push button switches (S1-S3) for external input stimulus

64k x 16 External SRAM

Microchip 24LC515 Serial EE memory device

2 x 16 character LCD

2 x 50 prototyping header for user hardware expansion (header not installed)
Prototype area for user hardware

1.6 dsPICDEM.net DEMONSTRATION PROGRAMS

The dsPICDEM.net Development Board is supplied with several sample application
programs for the dsPIC30F6014 to help you jump-start your own solutions. You will
need the MPLAB C30 Compiler to program these applications into the dsPIC30F
device. You can download a full-featured 60-day trial version of MPLAB C30 from the
Microchip web site (www.microchip.com). Follow the download links under
Products/Development Tools/Software.

Source code is provided on the Development Kit Software CD for all these
demonstration programs:

Tutorial — The tutorial introduces the new user to the basic skills needed to work
with the dsPIC30F. It provides step-by-step instructions for programming the
dsPIC30F chip with the MPLAB IDE and MPLAB C30 and debugging the program
with the MPLAB ICD 2. See Chapter 2. “Tutorial”.

dsPIC30F Quick Start — Building on the tutorial, the dcPIC30F demonstration
uses a sample application to illustrate functionality of the dsPIC30F and its
peripherals interacting with components on the dsPICDEM.net board. This
application is described fully in Chapter 3. “Quick Start Program”.

HTTP Web Server Demonstration — This sample application illustrates an
embedded web server that supports remote monitoring and control over a
10-Base T Ethernet connection. This demonstration program uses the
CMX-MicroNet TCP/IP Stack configured for HTTP Web Server protocol. This
sample application is described fully in Chapter 4. “HTTP Web Server
Demonstration”.

FTP Server Demonstration — This demonstration illustrates an embedded FTP
server application that provides remote monitoring and control over a 10-Base T
Ethernet connection. This sample application uses the CMX-MicroNet TCP/IP
Stack configured for FTP Server protocol. This demonstration is described fully in
Chapter 5. “FTP Server Demonstration”.

V.22bis Soft Modem Demonstration — The dsPIC30F6014 plug-in device is
pre-programmed with an ITU-T compliant V.22bis/V.22 modem demonstration that
lets you to connect and transfer data between the dsPIC30F Soft Modem and an
ITU-T compliant reference modem. This demonstration is described fully in
Chapter 6. “V.22bis Soft Modem Demonstration”.

DS51471A-page 10
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1.7 REFERENCE DOCUMENTS

The following documentation is available to support your use of the dsPICDEM.net
Development Board:

* dsPIC30F Family Reference Manual (DS70046)

» dsPIC30F Data Sheet, Motor Control and Power Conversion Family (DS70082)
* dsPIC30F Data Sheet, General Purpose and Sensor Families (DS70083)

* dsPIC30F5011, dsPIC30F5013 Data Sheet, High Performance Digital Signal
Controllers (DS70116)

» dsPIC30F6011, dsPIC30F6012, dsPIC30F6013, dsPIC30F6014 Data Sheet, High
Performance Digital Signal Controllers (DS70117)

» dsPIC30F Programmer’s Reference Manual (DS70030)

» dsPIC High Performance 16-bit Digital Signal Controller Family Overview
(DS70043)

* MPLAB C30 C Compiler User’s Guide (DS51284)

* MPLAB ASM30, MPLAB LINK30 and Utilities User’s Guide (DS51317)

* MPLAB ICD 2 In-Circuit Debugger Quick Start Guide (DS51268)

* MPLAB ICE Emulator User’s Guide (DS51159)

You can obtain these reference documents from your nearest Microchip sales office

(listed in the back of this document) or by downloading them from the Microchip web
site (www.microchip.com).
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NOTES:
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CONNECTIVITY DEVELOPMENT BOARD
MICROCHIP USER’S GUIDE

Chapter 2. Tutorial

21 INTRODUCTION

This chapter is a self-paced tutorial intended to get you started using the
dsPICDEM.net Development Board. The tutorial demonstrates basic techniques for
using the dsPIC30F development tools with the connectivity board.

2.2 HIGHLIGHTS

This chapter discusses:

+ Tutorial Overview
 Creating the Project

* Building the Code

* Programming the Chip
» Debugging the Code

* Summary

2.3 TUTORIAL OVERVIEW

This tutorial combines step-by-step instructions for using the dsPIC development tools
with files provided on the Development Kit Software CD to exercise key features of the
MPLAB IDE, MPLAB ICD 2 and MPLAB C30 for programming and debugging the
dsPIC30F chip.

There are three or four steps to this tutorial, depending on the debug tool being used.
1. Create a project in MPLAB

2. Assemble and link the code

3. Program the chip if the MPLAB ICD 2 is being used

4. Debug the code with the MPLAB ICD 2

The MPLAB ICD 2 is used in the tutorial to illustrate debugging.

2.4 CREATING THE PROJECT

The first step is to create a project and a workspace in MPLAB. Usually, you will have
one project in one workspace. A project contains the files needed to build an application
(source code, linker script files, etc.) along with their associations to various build tools
and build options. A workspace contains one or more projects and information on the
selected device, debug tool and/or programmer, open windows and their location, and
other IDE configuration settings. MPLAB IDE contains a Project Wizard to help create
new projects.

Before starting, copy the Tutorial files from the dsPICDEM.net Sample Applications
folder on the dsPICDEM.net Development Kit Software CD to your c:\ drive (see
Figure 2-1).
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FIGURE 2-1: TUTORIAL CODE FILES
\ doPIoDEN™ |1 i ;IsPICDEM.net Board Sample Applications |
* et I) FTP Server B T
[ (3 Quick Start 2KB CFile
—> o 1KE HFile
. ) v2zhis Saft-Modem ;_l dsPICDEMnet Tutorial.c 4 KB CFile
N — ) WEE Server E] Lep display.c 7KE CFile
EE 2] LD display b 1KE HFile

N\

Copy Tutorial folder from CD
to your C:\ drive

Your c: \Tutorial folder should now contain these files:
* delay.c

* delay.h

* dsPICDEM net Tutorial.c

* LCD Display.c

* LCD Display.h

Note: Files copied from the CD are read only; you will need to change the
attributes of files that need to be edited.

2.4.1 Select a Device

Start MPLAB IDE
Close any workspace that might be open (File>Close Workspace).
From the Project menu, select Project Wizard.

From the Welcome screen, click the Next> to display the Project Wizard Step
One dialog (see Figure 2-2).

hobd=

FIGURE 2-2: PROJECT WIZARD, STEP 1, SELECT A DEVICE
x

Step One:
Select a device /
e

Select dsPIC30F6014

< Back | Mext » I Cancel | Help I

5. Select dsPIC30F6014 as the device and click Next>. The Project Wizard Step
Two dialog displays (see Figure 2-3).
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FIGURE 2-3: PROJECT WIZARD, STEP 2, SELECT LANGUAGE
TOOLSUITE

Select Microchip C30 x|

Toolsute SlE%;:C?; language toolsuite EET/.{@}

-
m Microchip C30 Tookuite =]

— Toolsuite Content:

Specify file locations for
Assembler, Compiler
and Object Linker

— Location
\-IE:\picSD_tooIs\bin\picSD-gcc.exe Browse. .. I‘
Help! My Suite lsn't Listed! | [ Show allinstalled toolsuites
< Back | Mext » Cancel | Help I

2.4.2 Select Language Toolsuite

1. From the Active Toolsuite pull-down menu, select Microchip C30 Toolsuite. This
toolsuite includes the compiler, assembler and linker that will be used.
2. From Toolsuite Contents, select MPLAB ASM 30 Assembler (pic30-as.exe).
3. Inthe Location group, click Browse... and navigate to:
C:\pic30 tools\Bin\pic30-as.exe

Note: C:\is the drive implemented for this tutorial example. The specific location
on your system will depend on where you installed the MPLAB C30
compiler. If you haven’t purchased the MPLAB C30 compiler, you can
download a full-featured 60-day trial version from the Microchip web site
(www.microchip.com). Follow the download links under
Products/Development Tools/Software.

4. From Toolsuite Contents, select MPLAB C30 Compiler (pic30-gcc.exe).
5. Inthe Location block, click Browse... and navigate to:
C:\pic30_ tools\Bin\pic30-gcc.exe
6. From Toolsuite Contents, select MPLAB LINK30 Object Linker (pic30-Id.exe).
7. Inthe Location block, click Browse... and navigate to:
C:\pic30 tools\Bin\pic30-1d.exe.
8. Click Next> to continue. The Project Wizard Step Three dialog displays (see
Figure 2-4).
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FIGURE 2-4: PROJECT WIZARD, STEP 3, NAME YOUR PROJECT
rrosectwzard x
Step Three:
Name your project /@
Type a name for your

project...

~ Project Name -
IMyQuickStart

i~ Project Directory

|E:\Quick Start Browse... I
...and save it in the Project
Directory (C:\Tutorial)
< Back Mext > Cancel Help

243 Name Your Project

1. In the Project Name text box, type MyTutorial.

2. Click Browse... and navigate to C: \Tutorial to place your project in the
Tutorial folder.

3. Click Next> to continue.

244 Add Files to Project

1.  On the Project Wizard Step Four dialog (see Figure 2-5), locate the
C:\Tutorial folder and add these files to the right side.
dsPICDEMnet Tutorial.c
LCD Display.c
LCD Display.h
delay.c
delay.h

2. Navigate to the C:\pic30 tools\support\gld folder and add file
p30£6014.gld to include the linker script file in the project.

3. Navigate to the C:\pic30_ tools\support\h folder and add file
p30£6014 .h to include the header file in the project.

Note: The linker script file and header file locations for your environment may be

different. The location will depend on where you installed the C30 compiler.

DS51471A-page 16
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FIGURE 2-5: PROJECT WIZARD, STEP 4, ADD FILES TO PROJECT
ETTEE— =
Step Four: r‘h
. . Add any existing files to your project Ef
Add the Tutorial files and &
dsPIC30F6014 support
files for the to your newly 1 pic30_took s | [0 C:pic30_tookshsupportigldp0feL
created project &7 bin [ C:\pic30_toclshsuppantihhg 3066
-] docs O C:\Tutorialdelay.c
B fexamples Bl Femove | O C:ATutorialdelay. b
[1--% :_T:'“de O C:TutorishdsPICDEMnet Tutorial
o O C:\TutorishLCD display.c
ElD Sipport O C:ATutoriabLCD display.h
1 g
1h
] ine _|‘ —I _’I
L] templates _'ﬂ Check the box ta copy the file to the
_ﬂ | L project directory
< Back | Mext » I Cancel | Help |

4. There should now be seven files in the project. Click Next> to continue. The
Project Wizard Summary screen (Figure 2-6) displays the parameters of your

project.
FIGURE 2-6: PROJECT WIZARD SUMMARY SCREEN
rojectwizard x|

Summary

Project named “MyTutorial”
for dsPIC30F6014 device
will be saved to C:\Tutorial

Click Finish' to create the project with these parameters.

— Project P.
Device:  dsPIC30FE014

Toolsuite:  Microchip C30 Toolsuite
File: C:ATutorial\MyT utorial.mep

A new workspace will be created, and the new project added
to that workspace.

< Back Cancel Help

5.  Click Finish.
After the project wizard completes, the MPLAB project window shows the project and
all the added files (see Figure 2-7).

© 2004 Microchip Technology Inc.
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FIGURE 2-7: PROJECT WINDOW

_lix]

- MyTutorial.mcp
El- Source Files

: delay.c
dsPICDEMnet Tutorial.c
L LCD display.c
[=]- Header Files
delay.h

LCD display.h
p30fE014.h
- Obiject Files

- Library Files

inker Scripts

L p30FE014.qld
i Other Files

Project window displays the source
files, header files and linker script file
you added to your project

At this point a project and workspace have been created in MPLAB. MyTutorial . mcw
is the workspace file and MyTutorial .mcp is the project file. Double-click the
dsPICDEMnet Tutorial.c file in the project window to open it. MPLAB should look
similar to Figure 2-8.

FIGURE 2-8: MPLAB WORKSPACE

# MPLAB IDE v6.50

=1

ol

File Edit Wiew Project Debugger Programmer Tools  Configure Window  Help
D@ ima (8 |[ceRB|er
~loix]

[=l-MyProject.mcp

El Source Files

; delay.c
dsPICDEMnet Tutorial.c
LCD display.c

Header Files
delay.h
- LCD disple

dsPICDEMnet Tutorial.c

44 Tutorial code: Write LCD with text and flash LEDZ with a Timerl 1
i

#include "p30F6014 h"
#include "LCD Display h"

L Lopaofents
i Other Files

£
A4 Constante

gdefine Foy 7372200
#define LEDZ LATChits. LATC3

#/Define processor speed - instructic

£

const char LCD_Linel[]
const char LCD_LineZ[]

" dsPICDEM.net ":
Tutorial

5

|dsPIcaoFenis |

[ [ inyceli [ms [wR Y
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2.5 BUILDING THE CODE

In this project, the code is built in two stages, as shown in Figure 2-9. First the source
files are compiled into object files, then the object files are linked.

FIGURE 2-9: CODE BUILDING PROCESS

dsPICDEM.net Tutorial.c LCD display.c delay.c

Y Y Y

Compile | STAGEONE | Compile | STAGEONE | Compile

COMPILE COMPILE
dsPICDEM.net Tutorial.o LCD display.o delay.o
STAGE TWO Link
LINK

Y

MyTutorial.cof

MyTutorial.hex

The MyTutorial . hex output file contains the data necessary to program the device.
The MyTutorial.cof output file contains additional information that lets you debug
the code at the source code level.

Before building, there are compiler and linker settings that must be specified. These
settings indicate where to find the C library files and where to reserve space for the
extra debug code when the MPLAB ICD 2 (In-Circuit Debugger) is used.

251 Set Project Build Options

The tutorial project does not explicitly use any libraries, but the C compiler startup
library code is always automatically linked into the project. Use the Project>Build
Options>Project menu to specify the location of the library files as shown in
Figure 2-10.
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FIGURE 2-10: BUILD OPTIONS

Lo

2/ x|

Build Options For Project “M\|I'TuI:oriaI-.n'll:;_u;f:'-f'fé

General | MPLABR ASMBDI MFPLAB C30 | MPLAB LINK30|

Output Directory, $EINDIR]:

I Browse...

Intermediates Directory, $[TMPDIR):

Let the project know where the | Browse...
library files are located Assembler Include Path, $AINDIR):

I Browse...

Include Path, HIMCDIR]:

I Browse...

Library Path, $ILIBDIR):

IE:\picSD_tooIs\Iib Browse...

Linker-Script Path, $ILKRDIR]:

3NN

I Browse,..

Help | Suite Defaultsl

QK I Cancel | Apply

1. Select the Build Options General tab.

2. Add a Library Path by browsing to:
C:\pic30 tools\1lib

Note: The library path for your environment may be different. The location will
depend on where you installed the C30 compiler.

3. Select the MPLAB LINK30 tab to display the linker settings (see Figure 2-11).
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FIGURE 2-11: MPLAB LINK30 BUILD OPTIONS

Build Options For Project “MyTutoriaI.n‘l'cp'*? 5 ﬂﬂ

General | MPLAB ASM30| MPLAB C30  MPLAB LINKSO |

Categories: I General j

— Generate Command Line

Heap size: I buytes I~ Allow overlapped sections

Min Stack Size: | bytes ¥ Link for ICD2
Symbol Defi/
J/ &

Remove
/ﬂ Remave Al

ik

™| bt global sethngs Restore Defaults |
--C :-.E:Irl 1 : 'I:I“:;. .'I'. I: :.'I'.E; ..l::l:l.I

Check Link for ICD2

I Use Altemnate Settings

|-o"$rmHGETBASE Jcof*

0k I Cancel | Apply |

4. Check Link for ICD2 to tell the linker to reserve space for the debug code used
by the MPLAB ICD 2 In-Circuit Debugger.

5. Click OK.

2.5.2 Build the Project

At this point the project is ready to build.

1. From the Project menu select Make. The Build Output window displays (see
Figure 2-12).

2. Observe the progress of the build.

3. When the BUILD SUCCEEDED message displays you are ready to program the
device.
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FIGURE 2-12: BUILD OUTPUT
LI =10(x|
Buid |Version Eontroll Fird in Filesi
hake: The target "CATutoriahLCD display.o" is out of date. |

Executing: "Chpic30_tools\kbintpicil-goc.exe" -D__dsPIC30FE014__ -c-x ¢ "LCD display.c" -o"LCD display.0" g
Make: The target "ChTutorialibyTutorial. cof" is out of date.

Executing: "Chpic30_tools\binipic30-goc.exe” WL "Ch Tutarialhdelay.o"."CATutorialhdsFICDEMnet Tutarial. o, "CATutor
Executing: "CA\Program Files\WPLAB IDE\dsPIC_ToolsBin\picil-binZhex exe" "My Tutarial cof'

writing HyTutorial hex

section PC address byte address length {w~pad)} actual length {dec)

.reset 0 i} 0=8 O=z6  (6)
.text 0=100 0zz200 O=dec 0x3bl (945
.dinit 0x376 lxbec Oxd 0x3 (3}
.const 0x=378 O=6f0 O=44 0=33 (51}
Livt Oxd Ox=8 Oxfid Oxba (186)
.alvt O=84 O0=108 O=f8 O=zba {186)
.isr 0x=3%a 0=734 O=4d 0=z3 (3}
Total program memory used (bytes): O=z564 (13803

Executing: "ChProgram Files\MPLAE IDEVISFIC_Tools\BiniLooff_iCoff exe" "My Tutorial cof”

Loaded CATutorial\MyTutarial. cof b

BUILD SUCCEEDED: Mon ks 10 15:49:01 2004 =
|

il |

If you experience problems with the build, double check all the steps in this tutorial and
ensure that you are using the latest versions of the development tools. The latest
upgrades are available on the Microchip web site (www.microchip.com).

If there are errors in the source code, you can double-click the error messages in the
Output window and MPLAB will point to the offending line in the source code. This
should not happen if the files were copied from the dsPICDEM.net Development Kit
CD.

2.6 DEVICE CONFIGURATION AND PROGRAMMING

After you have built the code you must set up the configuration bits and then connect
the tool you plan to use for programming, running and debugging the code.

Note: Before proceeding, make sure that the USB driver for the MPLAB ICD 2 has
been installed on your PC (see the MPLAB ICD 2 User’s Guide (DS51331)
for more details regarding the installation of the USB driver).

2.6.1 Set Up Device Configuration

From the Configure menu select Configuration Bits to view the configuration bits (see
Figure 2-13). Accept the settings resulting from your build. However, make sure these
device categories are set up as shown here:

Category Setting

Oscillator Source Primary Oscillator

Primary Oscillator Mode XT w/PLL 4x

Watchdog Timer Disabled

Comm Channel Select Use PGC/EMUC and PGD/EMUD
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FIGURE 2-13: CONFIGURATION SETTINGS
Il Configuration Bits . =10 x|
Address Value Category Setcting |
Fsoooo FFFS Clock Switching and Monitor Sw Disabled, Mon Disabled
Oscillator Source Primary Oscillator
I Primary Oscillator Mode XT w/PLL 4x
Fa0o0o0oz 7FFF Watchdog Timer Dizabled
WDT Prescaler A 1:51z
WDT Prescaler E 1:16
Fso004 FFCF Master Clear Enable Enabled
PEOR Enshle Enshled
Brown Out Voltage T
POR Timer Value G4ms
Fa000A FFFF General Code Segment Code Protect Dizabled
General Code Segment Write Protect Disabled
Fs000C Coos Com Channel Select Tse PGC/EMUC and PGD/EMUD

After building the code and setting the configuration bits, use the MPLAB ICD 2
debugger to program the device and run and debug the code on the dsPICDEM.net
Demonstration Board.

2.6.2 Enabling the MPLAB ICD 2 Connection

The MPLAB ICD 2 can be used to program and debug the dsPIC30F6014 device
in-circuit on the dsPICDEM.net board.

Note: Before proceeding, make sure that the USB driver for the MPLAB ICD 2 has
been installed on your PC (see the MPLAB ICD 2 User’s Guide (DS51331)
for details regarding the installation of the USB driver).

1. Connect the MPLAB ICD 2 to the PC with the USB cable (see Figure 2-14).

2. Connect the MPLAB ICD 2 to modular connector labeled ICD on the
dsPICDEM.net board with the provided short RJ-11cable.

3. Apply power to the board.

FIGURE 2-14: TUTORIAL DEMONSTRATION SETUP
PC running MPLAB® IDE

dsPICDEM.net™ Connectivity

Connect MPLAB® ICD 2 to Development Board
PC with USB cable running Tutorial program

= " 04

\ Power Cable
IcD —2VDbC B 15 VAC

MPLAB ICD 2

p Apply power to the board
Connect MPLAB™ ICD 2 to board

with provided RJ-11 cable

© 2004 Microchip Technology Inc. DS51471A-page 23



PICDEM.net™ 1 and dsPICDEM.net 2 Connectivity Dev Board User’s Guide

4. From the Debugger>Select Tool menu, select MPLAB ICD 2 as the debug tool.
5. From the Debugger menu, select Connect. MPLAB should report that it found the

dsPIC30F6014 as shown in Figure 2-15.

Note: MPLAB may need to download new firmware if this is the first time the
MPLAB ICD 2 is being used with a dsPIC30F device. Allow it to do so. If
any errors are shown, double-click the error message to get more
information.

FIGURE 2-15:

ENABLING MPLAB ICD 2

Mouput 10 x|
Build | Version Contral | Findin Files MPLABIED 2 |

Connecting to MPLAB ICD 2
..Connected

ICDWarn0030: MPLAE ICD2 is aboutto download & new operating systerm: f MPLAB IDE is just starting, itwill appearto "l
Downloading Operating Systerm

Connecting to MPLAB ICD 2

..Connected

Setting Ydd source to target

Target Device dsPIC30FE0T4 found, revision = 0x40
..Reading ICD Product ID

Funning ICD Self Test

..Fassed

Download Operating System Succeeded

Setting Ydd source to target

Target Device dsPIC30FE0T4 found, revision = 0x40
..Reading ICD Product ID

Funning ICD Self Test

..Fassed

MPLAE ICD 2 Ready

4] | i

From the Debugger menu, select Settings to display the ICD Debugger settings
(see Figure 2-16).

FIGURE 2-16: MPLAB ICD 2 DEBUGGER SETTINGS
Statuz | Communication I Limitations I Power I
Program | Versiong I Warhings
& Allow ICD 2 to select memories and ranges
A Manually select memaories and ranges
= emanes Frogram Dptiors
| Fragranm ¥ | Freeze on Halt
¥ Canfiguration ¥ | Erase all before Program
I~ EEFROH
Make sure this option is selected: il
Allow MPLAB ICD 2 to select e

memories and ranges

= External bemarny
[hex] [hex]

= Frograr temor

Start |Ux'fl Start |ElxD

End IDxSBF Eridl ||un

Full Hangel Full Hangel

= Bootloader
WzerMeman Houtines
|\IED2\IED2.INI Browse... |

ak I Cancel | Apply | Help |
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7. On the Program tab, ensure that Allow ICD 2 to select memories and ranges
is selected. This setting will speed up programming by addressing only a small
part of the total program memory.

8. Program the part (Debugger>Program). The Output window shows the results of
the programming cycle as shown in Figure 2-17. The part is now programmed
and is ready to run.

FIGURE 2-17: MPLAB ICD 2 PROGRAM READY
Mowest 1ol x|
Build | Version Contral | Findin Files MPLABIED 2 |
MPLAB ICD 2 Ready =
Frogramming Target..
...Erasing Part

..Programming Program Memary (0x0 - 0x3BF)
...Loading DebugExecutive
..Programming DebugExecutive
..Programming Debug Yectar
..Programming Configuration Bits
erifying...

...Program Memaory

...Debug Executive

..Debug Vector

WMerify Succeeded
...Programming Configuration Bits
.. Config Memaory

“Yerifying configuration memary..
Connecting to debug executive
..Programming succeeded
MPLAB ICD 2 Ready

4 | o

9. Run the code (Debugger>Run). The MPLAB Output window should indicate that
the target is running (see Figure 2-18).
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FIGURE 2-18:  TUTORIAL PROGRAM RUNNING
Il

File Edit Yiew Project Debugger Programmer Tools Configure  Window  Help

j[oEa|sma|se CEER(SE| Uk | wne

[=1- MyTutorial. mcp
= rce Files
delay.c
dsPICDEMnet

LCD displary.c | g | Wersion Cantral | Findin Files  MPLAB IED 2 |

Connecting to MPLAB ICD 2
..Connected
Setting Vdd source 1o target
Target Device dsPICI0FG0T 4 found, revision = 0xdl
Reading ICD Praduct D
Funning IC0 Self Test
Passed
MPLAB ICD 2 Ready
ICDWarn0015: Prograrn mermory has changed since last prograrm operation? Continue with Debug operation?
Stepping Target
MPLAB ICD 2 Ready Project status bar
Connecting to MPLAB ICD 2 .
Connected shows program running
Setting Vdd source to target
Target Device dsPICI0FG0T4 found,
Feading ICD Product ID
Funning IC0 Self Test
.Passed
MPLAB ICD 2 Rea
Running Target

Other Files

Output window shows
program running

RURRAg. ... AINNNNNNENEEE A

On the board, LED2 should start blinking and the LCD display should display the
following text:

dsPICDEM.net
Tutorial

Note: When debugging with MPLAB ICD 2, it is always necessary to reprogram
the part with the new code after each build. MPLAB will remind you with a
message that states “Program memory has changed since last operation.”
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2.7 DEBUGGING THE CODE

The MPLAB ICD 2 debugger/programmer can be used to run, halt, and step the code.
You can set a breakpoint so that program execution halts after the code has executed
the instruction at the breakpoint. A green arrow points to the next line to be executed.
The contents of the RAM and registers can be viewed when the processor has been

halted.
MPLAB ICD 2 uses the following function keys to access the main debugging functions:
<F5> Halt
<F6> Reset
<F7> Single Step
<F9> Run

There are more functions available by right clicking on a line of source code. The most
important of these are Sef Breakpoint and Run to Cursor.

271 Display the Code

1. From the View menu, select Program Memory. The Program Memory window
displays.

2. Select the Symbolic tab at the bottom of the window.

3. Press <F5> to halt the processor. The program stops and the green arrow points
to the next instruction, as shown in Figure 2-19.

FIGURE 2-19: PROGRAM HALTED
lgix]
Line Address Opcode Lakel Disassenbly fret
i
Z90 00z 42 FES000 ze. b wi,wd
291 00z 44 s00061 and.w wi,#1,w0
292 a0zZ46 ECQOooo cpd.w wid
=53 2093 00245  32FFF9 bra =z, .LZ
294 00244 A98054 belr.b IF30,#3
Z95 a0z 4c BFCZDO mowv.b LATC, wl
I 29A NNz 4w FRAOON =e b Wi I _ILI
4 3
Opcode Hexl Machine“ Symbalic  PSY Mixedl PSY Datal

4. Press <F6> toreset the program. The green arrow moves to address 00000, the
goto _reset instruction, as shown in Figure 2-20. The linker inserted this
instruction to make the program branch to the start of the code.

FIGURE 2-20: PROGRAM RESET
=1
Line Address Opcode Lakel Dizsassenbly o
= 1 00000 040100 goto _reset
2 aoooz aooooog nop
3 aooo4g 000394 nop
4 aooos 000394 nop
5 aooos 000394 nop
& O0o0a 000394 nop
7 0NNNC NAN39i nan z
«| | »
Opcode Hexl Machine" Symbolic  PSY Mixed | PSY Data
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2.7.2 Step the Program

1. Press <F7> to single step the code. The green arrow moves to line 129, reset
mov.w #0x850,wl5, as shown in Figure 2-21.

This code comes from a library (archive) file, 1ibpic30.a, which is
automatically linked into C30 compiler projects. This code line initializes the stack
pointer and is part of the initialization code that the C30 compiler uses to set up
the stack and initialize data. Notice line 135, call main. This instruction calls
the main () routine from the dsPICDEMnet Tutorial.c source file.

FIGURE 2-21: PROGRAM SINGLE STEPPED

JRI=TEY
Line Address | Opcode | Label Disassembly =
1za OO0F A 000394 nop
1z7 Qo0FC 000394 nop
1zg OO0O0FE 000394 nop
E§> 129 goioo 20850F _reset mov.w #0x850, w15
130 ooiloz Z27960 mov.w HOXZ796,wd
131 o104 gs0100 mwov.w wl,SFLIN
13z oo1o06 aooooo nop
133 oo1os 070005 rcall psv_init
134 00104 Q7oooc rcall data init
135 oo1oc 0z0z0C call main
136 O010E aooooo nop
137 oo1i0 DAa4000 ReservedER -
4 =
Opcode Hexl Machine” Symbalic  PSY Mixedi PSY Datal

2. Openthe dsPICDEMnet Tutorial.c source file. Double click on the file name
in the Project Window if the file is not already open.

3. Select and right click line TMR1 = 0;, then choose Run to Cursor., as shown
in Figure 2-22.

FIGURE 2-22: RUN TO CURSOR COMMAND

Il C:', Tutorial',dsPICDEMnet Tutorial.c [ 10l =l
e g
#define LEDEZ LATChits.LATCZ j
Close
£
Set Breakpoink
const char LCL  Breakpoints b |CDEM.net
const char LCT—  fktorial
Run ko Cursor
Right-click TMR1 = 0 Set PC at Cursor
and select |t o

f/ Main routir g

int main( veid OFY

{ Faste
LATC = OxC Delete /¢ Turn LEDL, LEDZ and LEDS off
TRISC = Ox F£f Bet LED pins as outputs
Add To Project

Run to Cursor

TICON = 0; Advanced » /¢ Turn off Timerl by clearing co
\ THMEREL = 0; Bookmarks 3 4 Btart Timerl at zero
N PR - Fey/ TextMode » /¢ Load Timerl pericd register fo
T1CON = Ox Properties. .. £/ Load Timerl settings for 1:Z5&
Init_LCD () f¢ Initialize LCD
home _clr(); £ Clear screen and home cursor_lLI
|41 | »

The code runs briefly until it reaches the specified line. It then halts with the green
arrow pointing to the next line, as shown in Figure 2-23.
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FIGURE 2-23: PROGRAM HALTED AT CURSOR LOCATION

Green arrow shows Il C:, Tutorial',dsPICDEMnet Tukorial.c 1 =10l =l
where program halts TRISC = OxFFE3; /7 Set LED pins as outputs zl
T1CON = 0; A4 Turn off Tiwmerl by clearing co
~ THR1 = 0O; £ Btart Timerl at zero
S~ Ez} | PR1 = FeysElEZ; A# Load Timerl period register fo
T1CON = 0Ox20320; £# Load Timerl settings for 1:Z5&
Init_LCD0); A4 Initialize LCD
home_clril: A4 Clear screen and home cursor
Puts_LCD({ (char *)siLCD_Linel[0], (sizeof(LCD_Linel); - 1 i;
line Zi}; £F Go to line Z of the display
Puts_LCD i (char *)&LCD_LineZ[0], (sizeof(LCD_LineZ)) - 1 |;
while{ 1 ) £f Loop forewver
{
ifi{ IFS0bits. T1IF | A/ Check for Timerl timeout
i
IFS0bits.T1IF = 0O; A4 Clear Timerl interrupt flag
LEDZ = ~LEDZ; /¢ Toggle LEDZ
i
i3 -
1| ;l_l

4. From the View menu select Watch to open a Watch Window.

5. Select PR1 from the SFR pull-down list, then click Add SFR. The PR1 register
is added to the Watch Window, as shown in Figure 2-24.

6. Press <F7> twice. Watch the PR1 value change to 0x3840 as the green arrow
moves to PR1 = Fcy/512; in the code window.

FIGURE 2-24: WATCH WINDOW DISPLAY

([ o

AddSER| [acca =] Add Symbol| [bss ~|
hddress I Symbol Name I Value I
a0za ACCA Ox0000000000

['watch1 Watch2| watch3| watch4|

273 Set Breakpoint

1. To set a breakpoint, right-click a line and select Set Breakpoint from the pop-up
menu.

Note: An alternate method is to simply double click the line. This feature may
need to be enabled by using the Edit>Properties menu.

For this example, find the following line of code and set a breakpoint.
IFSObits.T1IF = 0;
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2.8 SUMMARY

A red stop sign should appear in the gutter (grey bar on the left) of the source
code window, as shown in Figure 2-25.

2. Press <F9> to run the code. The program will halt on the instruction following the
breakpoint.
In this example, every time <F9> is pressed to run the code, the program runs
through the timing delay loop once before reaching the breakpoint. It toggles
LED2 each time.
FIGURE 2-25: SETTING BREAKPOINT
Il C:", Tutorial',dsPICDEMnet Tutorial.c L -IEllﬂ
TRISC = OxFFE3; £4 Bet LED pins as outputs j
TI1CON = 0O; F4 Turn off Timerl by clearing co
THMR1l = 0O; A4 Btart Timerl at =zero
PRl = Feoy/sEl:Z: £ Load Timerl periocd register fo
E§> | TICON = 0x20320; f¢ Load Timerl settings for 1:ZE&
Initc_LCD () ff Initialize LCD
home_clri): FF Clear screen and home cursor
Puts_LCDl:l:char *:IdLCD_LinellDl, (sizeof(LCD_LinelJJ = 1&g
line 21{); ff Go Lo line Z of the display
Pucts LCD (char *)&LCD_LineZ[0], i(sizeof(LCD LineZ)) - 1 };
while 1 } f¢ Loop forewver
{
ifi IFE0bits_T1IF £ Chechk for Timerl timeout
1
@ IFS0khit=s_T1IF = 0O; f4 Clear Timerl interrupt flag
LEDZ = ~LEDZ: /¢ Toggle LEDZ
1
1 -
I 4 I I »

This tutorial has demonstrated several features of the MPLAB IDE programmer and the
MPLAB C30 compiler. It also demonstrated the use of the MPLAB ICD 2 debugger with
the dsPICDEM.net board. After completing this tutorial you should be able to:

Create a project using the project Wizard.

Compile and link the code and set the configuration bits.

Set up MPLAB to use the MPLAB ICD 2.

Program the chip with the MPLAB ICD 2.

View the code execution in program memory and source code.
View registers in a Watch Window.

Set a breakpoint and make the code halt at a chosen location.

Use the function keys to Reset, Run, Halt and Single Step the code.

You can now add functionality to this simple project to create your own application.

To familiarize yourself with several dsPIC peripherals and associated board functions
proceed to Chapter 3. “Quick Start Program”. The quick start sample project in
Chapter 3 provides several code module building blocks to help you accelerate your
proficiency with the dsPICDEM.net board.
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Chapter 3. Quick Start Program

3.1 INTRODUCTION

This chapter describes a demonstration program made up of several Assembly and C
module building blocks that exercise dsPIC30F peripherals and associated hardware
on the dsPICDEM.net Development Board. These code modules are intended to
increase your comfort level with the dsPIC by getting you started initializing and
controlling peripherals. Additional code modules are provided to initialize and perform
loopback tests on board hardware such as the 64Kx16 SRAM, RealTek 10-Base T NIC
and Si303x Data Access Arrangement (DAA) and Analog Front End (AFE) circuits.

3.2 HIGHLIGHTS

This chapter discusses:

* Quick Start Program Overview

 Creating the Project

+ Building the Code

+» Device Configuration and Programming

* Interacting with the Code

* Quick Start Demonstration Features and Peripherals
» Data and Control Flow

* Summary

3.3 QUICK START PROGRAM OVERVIEW

The quick start program is provided to accelerate your proficiency in working with the
dsPIC30F device and dsPICDEM.net Development Board to create your own
embedded solutions. The building block code modules can be used to initialize and
control several dsPIC peripherals and associated board functions.

The quick start program will also increase your familiarity with the dsPIC software
development tools. You will use the MPLAB IDE to create a quick start project. You will
use the MPLAB C30 compiler to build the quick start program. And you will use the
MPLAB ICD 2 debugger to program the dsPIC30F chip and debug the program on the
board. If you have not yet purchased the MPLAB C30 compiler you will need to
download and install the full-feature 60-day trial available from the Microchip web site.

The quick start program basically displays information on the LCD screen and toggles
LEDs in response to specific actions. Source files are provided on the dsPICDEM.net
Development Kit Software CD in the dsPICDEM.net Board Sample Applications/Quick
Start folder. Full source code is provided to assist in debugging.

The source files are used with a linker script file (p30£6014 .g1d) and a header file
(p30£6014 .h) from the MPLAB C30 compiler to form a simple quick start project. As
you work with the step-by-step instructions you will become increasingly familiar with
key features of the dsPIC30F.
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There are three or four steps to this quick start, depending on the debug tool being
used:

1. Create a project in MPLAB

2. Assemble and link the code

3. Program the chip if the MPLAB ICD 2 is being used
4. Debug the code with the MPLAB ICD 2

The MPLAB ICD 2 is used in the quick start procedures to illustrate debugging.

3.4 CREATING THE PROJECT

The first step is to create a project and a workspace in MPLAB. Usually, you will have
one project in one workspace. A project contains the files needed to build an application
(source code, linker script files, etc.) along with their associations to various build tools
and build options. A workspace contains one or more projects and information on the
selected device, debug tool and/or programmer, open windows and their location, and
other IDE configuration settings. MPLAB IDE contains a Project Wizard to help create
new projects.

Before starting, copy the Quick Start folder on the dsPICDEM.net Development Kit
Software CD to your c:\ drive (see Figure 3-1).

Note: Files copied from the CD are read only; you will need to change the
attributes of files that need to be edited.

FIGURE 3-1: DEMONSTRATION CODE FILES

Copy Quick Start folder
from CD to your C:\ drive

% dsPICDEM™
* Deveiopmert [l I[2) dsPICDEM. net Board Sample Applications I V

[# |J) FTP Server Mame = I Size ’ Type |
» [EXR Ry ick Skart ©h File Folder
& [ Tuterial Cinc File Folder
= H (5 v22bis Soft-Modem C)source File Folder
SGEE [# =) WEE Server
The folder should contain these files:
h files:
e defines.h enic init param.h
e delay.h enic strings.h
e lcd.h e strings.h
inc files

e device Fcy.inc
e Si3021 mode.inc
e Si3021 outputs.inc
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source files

e 1khz.s e init Sram.c

e 2khz.s einit Timers.s
e bin2dec.c e init Uart.s

e Dac_Update.c e isr Adc.s

e delay.c e isr Dci.s

e device config.s e isr INTpin.s

e display.s e isr RealTek NIC.s
e init Adc.s e isr Timers.s

e init Dci.s e isr Uartl tx.s
e init INTpin.s e lcd.c

e init Ports.s ® main.c

e init RealTek NIC.c e TestCAN.c

e init Si3021.s e TestUartl.c

e init Spil.s e traps.c

3.4.1 Select a Device

Start MPLAB IDE.
Close any workspace that might be open (Eile>Close Workspace).
From the Project menu, select Project Wizard.

From the Welcome screen, click the Next> to display the Project Wizard Step
One dialog (see Figure 3-2).

pPoODd =

FIGURE 3-2: PROJECT WIZARD, STEP 1, SELECT A DEVICE

Project Wizard ) x|

Step One:
Select a device /
e

Select dsPIC30F6014

Device:

< Back | Mext » I Cancel | Help I

5. Select dsPIC30F6014 as the device and click Next>. The Project Wizard Step
Two dialog displays (see Figure 3-3).

© 2004 Microchip Technology Inc.
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FIGURE 3-3:

PROJECT WIZARD, STEP 2, SELECT LANGUAGE
TOOLSUITE

HProject wizard j |

Step Two: r‘h
1 Select a language toolzuite
-
EEEEEEEEEEESEESEEEEEEEEEEEEN
Active Toolsuite: Microchip C30 Toolsuite ;] :

Select Microchip C30
Toolsuite

[
[
B Toolsuite Content u
B . . . .
Specify file location for x e ]
Assembler u MPLAE LINK30 Dbject Linker [pic30-1d exe] .
[ ]
[ = ]
n i~ Lacation n
C:Apic30_tools\binspic30-as. exe Browse. .. I |
[

.------------------------k----

Helpl My Suite [sn't Listed! I~ Show all installed toolsuites

< Back | Mext » I Cancel | Help |

L o : : . ; -8

1 Active Toolsuite: Microchip C30 Toolzuite __I .

: — Toolsuite Contents | :

Specify file location for X MPLAE ASM30 Assembler [pical-as.exe n

H MPLAR C30 C Compiler [pic30-goc. exe]

Compiler : MPLAR LINK30 Object Linker [picatid.exe) :
| [ ]

B [ Location ]

C:hpic30_tools\binhpic30-goc. exe Browse. .. n

1 (oo ]

-------------------------h----

: Active Toolsuite: Microchip C30 Toolsuite ;] :

: — Toolsuite Content: | :

Specify file location for " MPLAB ASM30 Assembler (pic30-as.exe] "

. . MPLAE C30 C Compiler [pic30-goc.exe

Object Linker ol HPLAB LINK3D Dbjsct Linker [pica0id.exe] E
| | ]

| ]

g [ Location n

-4pic30_toolshbintpic30-1d. exe Browse. .. L]

| 8 B |

3.4.2
1.

2.

Select Language Toolsuite

From the Active Toolsuite pull-down menu, select Microchip C30 Toolsuite. This
toolsuite includes the compiler, assembler and linker that will be used.

Set Toolsuite Contents to MPLAB ASM 30 Assembler (pic30-as.exe).

Set Location to: C:\pic30 tools\Bin\pic30-as.exe.

Note:

C:\is the drive implemented for this example. The specific location of the
MPLAB C30 compiler may be different on your system.

© N Ok

Reset Toolsuite Contents to MPLAB C30 Compiler (pic30-gcc.exe).

Set Location to: C:\pic30 tools\Bin\pic30-gcc.exe.

Reset Toolsuite Contents to MPLAB LINK30 Object Linker (pic30-Id.exe).
Set Location to: C:\pic30 tools\Bin\pic30-1d.exe.

Click Next> to continue. The Project Wizard Step Three dialog displays (see
Figure 3-4).
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FIGURE 3-4: PROJECT WIZARD, STEP 3, NAME YOUR PROJECT
proectwzard zn
Step Three:
Mame your project /{é}

Type a name for your
project...

— Project Mame
MyGuickStart

— Project Directory

C:AQuick Start Erowse. . I

...and save it in the Project
Directory (C:\Quick Start)

< Back Mext » Cancel Help

3.4.3 Name Your Project

1. In the Project Name text box, type MyQuickStart.

2. Click Browse... and navigate to C:\Quick Start to place your project in the
Quick Start folder.

3. Click Next> to continue.

344 Add Files to Project

1. On the Project Wizard Step Four dialog (see Figure 3-5), locate the C: \Quick
Start folder and add all the hex, source and include files to the right side.

Select and add all the files in the Quick Start/h folder:

e defines.h enic init param.h
e delay.h e nic_strings.h
e lcd.h e strings.h

Select and add all the files in the Quick Start/inc folder:

e device Fcy.inc
® 313021 mode.inc
e Si3021 outputs.inc

Select and add all the files in the Quick Start/source folder:

e bin2dec.c e init Adc.s

® Dac_Update.c e init Dci.s

e delay.c e init INTpin.s
e init RealTek NIC.c e init Ports.s

e init Sram.c e init Si3021.s
elcd.c e init Spil.s

e main.c ¢ init Timers.s
e TestCAN.c e init Uart.s

e TestUartl.c e isr Adc.s

e traps.c e isr Dci.s

e 1khz.s e isr INTpin.s

e 2khz.s e isr RealTek NIC.s
e device_ config.s ¢ isr Timers.s

e display.s e isr Uartl tx.s
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2. Navigate to the C:\pic30 tools\support\gld folder and add file
p30£6014.gld to include the linker script file in the project.

3. Navigate to the C:\pic30_ tools\support\h folder and add file
p30£6014 .h to include the header file in the project.

Note: The linker script file and header file locations for your environment may be
different. The location will depend on where the C30 compiler is installed.

FIGURE 3-5: PROJECT WIZARD, STEP 4, ADD FILES TO PROJECT
x
Step Four:
Add any existing files to your project /
Add the Quick Start files 2t

and dsPIC30F6014
support files to your newly
created project

d T | O C:\Quick Start\source\isr_F!eaul
[ C:\Quick Startssourcedisr_Time
[ C:\Quick Starthsourcedisr_Uart:

Femaove | O C:\Quick Startssourcedled.c

[ C:\Quick Startsourcemain.c
[ C:\Quick StarthsourcedSi3021_

[ C:\Quick StartssourcesT estCAL
O C:\Quick Start\source\TestUjﬁ
3

O C:MQuick Stathsourceiraps.c -
0 |

Check the box to copy the file ta the
project directony

< Back | Mext > I Cancel | Help |

4. Click Next> to continue. The Project Wizard Summary screen (Figure 3-6)
displays the parameters of your project.

FIGURE 3-6: PROJECT WIZARD SUMMARY SCREEN
zl

Summary

Project named
“MyQuickStart” for
dsPIC30F6014 device will
be saved to C:\Quick Start

Click Finish' to create the project with these parameters.

Project P
Device:  dsPIC30FE014

Toolsuite:  Microchip C30 Toolsuite

File: C:A\Quick Start\MyQuickStart. mep

A new workspace will be created, and the new project added
to that workzpace.

Cancel Help

< Back

5. Click Finish.
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After the project wizard completes, the MPLAB project window shows the project and
all the added files (see Figure 3-7).

FIGURE 3-7: PROJECT WINDOW

=10j |

=+ MyQuickStart.mcp
El- Source Files

- 1khz.5

- 2khz.s

- hinZdec.c

- Dac_Update.c

- delay.c

- device_config.s

- display.s

- init_aAdc.s

- init_Dici. 5

- init_IMTpRin.s

- init_Ports.s

- init_PealTek_NIC.c

- inik_Si3021 .5

- inik_Spil.s

- inik_Sram.c

- init_Timers.s ;I

Project window displays the files you
added to your MyQuickStart project

At this point a project and workspace have been created in MPLAB.

MyQuickStart .mcwis the workspace file and MyQuickStart .mcp is the project file.
Double-click the main. ¢ file in the project window to open it. MPLAB should look
similar to Figure 3-8.

FIGURE 3-8: MPLAB WORKSPACE
P FIE]-

Fle Edit Wiew Project Debugger Programmer iools Configre Window Help E
D ima a2 loem|en | vuna ok Rhe 2
=
e _oix .
My lickSEaftmep B C:\Quick Start\sourceimain.c i
£ Source Files Filename : main.c o7 |
- khz.s Date . 05/17/2004
- 2khz.s
- binzdeac.c ; Bew: Date: Details:
- Dac_Update.c |
i Lo 17 HMay 2004 Initial Demo Code Release
- delay.c
- devics_config.s
- display.s Other Files Required: p30F60ld.gld, p30£6014.inc

Tools Used:MPLAE IDE © E.E80.00
ASM30 Assembler : 1.20.01
Linker c l.zo.01

Devices Supported by this file:
4sPIC 3076014

Additional Netes:

Basic demo code for imivializing and comtrol several dsPIC peripherals

~isr_Drl.s

---isrilNTpin‘s and board functions.

e RealTekNIC, 1. Complete demo functionality tested ko 29.5 MIPs.
isr_Timers.s Z. No C module optimizations enahled
isr_Uart]_tx.s 3. 4sPIC dewice configuration set in device config.s fils
led.c 4. dsPIC PLL mode set in dewice Foy.ine file
main.c 5. Adjustment of delay routines supported in delay.h file
TestCAN.c
TestUartl c
traps.c

(= Header Files = #include "p30FE014.h"

defines.h #include "defines h"
delay.h #include "led.h”

#include "strings h'

device_Foy.inc
finclude "delay.h"

led.h
nic_init_param.h
nic_strings.h
p30FE014.h Ja|
[MPLABICDZ | [dsPIC30FE014  [pcid [oabsab1P0 [denovze | [ [ int, ot S R

EEETNE B

| 9 ciquick start - picrosef .. .,\ MPLAB IDE v6.50

Aistart| | & (@ © > | @ Deanloveioy -Inbox-L... | B adobe FrameMaker
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3.5 BUILDING THE CODE

In this project, the code is built in two stages. First the source files are compiled into
object files, then the object files are linked.

The MyQuickStart . hex output file contains the data necessary to program the
device. The MyQuickStart . cof output file contains additional information that lets
you debug the code at the source code level.

Before building the program, compiler and linker settings must be specified. These
settings indicate where to find the C library files and where to reserve space for the
extra debug code when the MPLAB ICD 2 (In-Circuit debugger) is used.

3.51 Set Project Build Options

The Quick Start project does not explicitly use any libraries, but the C compiler startup
library code is always automatically linked into the project. Use the Project>Build
Options>Project menu to display the Build Options dialog.

1. Select the General tab.

2. Type or browse to the file locations shown in Figure 3-9.

FIGURE 3-9: BUILD OPTIONS
Build Options For Project "MyQuickStarE.mcp™ e |
Let the project know where the General I MPLAB ASM30 | MPLAB C30 | MPLAB LINK3D |
output files will be located
Output Directory, $BINDIR]:
& Browse... |
Intermediates Directory, $[TMPDIR]:
lobi Browse... |
Azzembler Include Path, $iAINDIR]:
IE:\picSD_tooIs\support\inC;E:\Quic:k Starthinc Browse. .. |
Include Path, $INCDIR]:
]E:\Quick Startih Browse... |
Library Path, $ILIBDIR):
IE:\picSD_tooIs\Iib Browse... |
Linker-Script Path, $ILKRDIR]:
|
Help | Suite Defaultsi
’TI Cancel | Apply |

Note: The library path for your environment may be different. The location will
depend on where you installed the C30 compiler.

3. Select the MPLAB LINK30 tab to display the linker settings.

4. Check Link for ICD2 to tell the linker to reserve space for the debug code used
by the MPLAB ICD 2 In-Circuit Debugger (see Figure 3-10).

5. Click OK.
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FIGURE 3-10: MPLAB LINK30 BUILD OPTIONS

Build Options For Project "MyProject.mep® ﬂﬂ

General | MPLAB ASM30| MPLAB C30 MPLAB LINK3D |

Categories: I General j

— Generate Command Line

Heap size: I buytes I~ Allow overlapped sections
Min Stack Size: | bytes ¥ Link for ICD2

Symbaol Definiti
j/ Add
Remove
/ﬂ Remave Al

™| bt global sethngs Restore Defaults |

Check Link for ICD2 [asfeym=_CD2RAM=1 o"$(TARGE TBASELcof

ik

e

I Use Altemnate Settings

|-o"$rmHGETBASE Jcof*

0k I Cancel Apply

3.5.2 Build the Project

At this point the project is ready to build.

1. From the Project menu select Build All. The Build Output window displays (see
Figure 3-11).
2. Observe the progress of the build.

3. When the BUILD SUCCEEDED message displays you are ready to program the
device.

FIGURE 3-11: BUILD OUTPUT

(I ol
Build | Version Conirol | Find in Files | MPLAB 12D 2 |
.reset o o 0x8 Ozt (6]} _I
. text 0=l00 0=200 Ox28£8 Oxleba (7866}
dinit 0x157c Ox2afd O=518 O0=3d2 (978)
___FOSC OxfE0000 Oz1f00000 Ox4 0=2 (2]
___FWDT Oxfe0002 Ox1£00004 Oxd 0x2 (2}
__FBORFPOR Oxfe0004 Oxlf00008 Ox4 0=2 (2)
___FGS Oxf8000a Ox1£00014 Ox4 Oz2 (2]
const 0x1808 0=x3010 O=2dc 0=225 (549)
Liwt Oxd 0= O=f8 Oxba (186}
Laivt 0=B84 0xl0g O=fg Oxba (186}
.sinewvave_lkhz 0=1976 O=ziiec O=al 0=78 (120}
.sinewave_2khz 0=19ch 0=338c 0=x140 O=f0 (240}
isr Oxlabs 0x34cc Oxd 0=3 (3}
Total program memory used [(bytes): 0x27a2 (10146}
Executing: "CAProgram Files\MPLAB |DE\dSP|C_T]OU\S\Bin\LCDﬁ_iCUﬁ.eXE" "CAQick StartthexMyCuickStarnt. cof!
Loaded C\Quick StarthexiMyCQuickStart. cof
BUILD SUCCEEDED: Tue May 18 09:14:70 2004
KT — _>lJ

If you experience any problems with the build, double-click the error messages in the
Output window and MPLAB will point to the offending line in the source code. This
should not happen if the files were copied from the dsPICDEM.net Development Kit
CD. Double check all the steps in this section and ensure that you are using the latest
versions of the development tools. The latest upgrades are available on the Microchip
web site (www.microchip.com).
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3.6 DEVICE CONFIGURATION AND PROGRAMMING

After you have built the code you must set up the configuration bits and then connect
the tool you plan to use for programming, running and debugging the code.

Note: Before proceeding, make sure that the USB driver for the MPLAB ICD 2 has
been installed on your PC (see the MPLAB ICD 2 User’s Guide (DS51331)
for more details regarding the installation of the USB driver).

3.6.1 Set Up Device Configuration

From the Configure menu select Configuration Bits to view the configuration bits and
set up the bits as shown in Figure 3-12. The settings that will most likely need to change
are:

Oscillator Source Primary Oscillator

Primary Oscillator Mode XT w/PLL 8x

Watchdog Timer Disabled

Comm Channel Select Use PGC/EMUC and PGD/EMUD

FIGURE 3-12: CONFIGURATION SETTINGS

~lo|x|

Address I Value I Category | Setting |

Fs000oo FFFa Clock Switching and Monitor Sw Disabled, Mon Disabled
Oscillator Source Primary Oscillatgr L
Primary Oscillator Mode ZT w/PLL 8x #

Fao0ooz TFFF Watchdog Timer Disabled«
WDT Prescaler A 1:51z
WDT Prescaler E 1:16

Fs0004 FEEGE Master Clear Enable Enabled
PEOR Enable Enabled
Brown Out Voltage 4,5V
POR Timer Value 64ms

F30004 FFFF General Code Segment Code Protect Dizabled
General Code Segment Write Protect Disabled

Fs000C Coos Comm Channel Select Use PGC/EMUC and PGD/EMUD «

After building the code and setting the configuration bits, the MPLAB ICD 2 debugger
can be used to run and debug the code on the dsPICDEM.net Demonstration Board.
Follow the instructions in one of the next two sections depending on which tool you are
using.

3.6.2 Enabling the MPLAB ICD 2 Connection

The MPLAB ICD 2 can be used to program and debug the dsPIC30F6014 device
in-circuit on the dsPICDEM.net board.

Note: Before proceeding, make sure that the USB driver for the MPLAB ICD 2 has
been installed on your PC (see the MPLAB ICD 2 User’s Guide (DS51331)

for details regarding the installation of the USB driver).

1. Connect the MPLAB ICD 2 to the PC with the USB cable (see Figure 3-13).

2. Connect the MPLAB ICD 2 to modular connector labeled ICD on the
dsPICDEM.net board with the provided short RJ-11 cable.

3. Apply power to the board.
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FIGURE 3-13: dsPICDEM.net™ DEVELOPMENT BOARD CONNECTED TO
MPLAB® ICD 2

PC running MPLAB® IDE

dsPICDEM.net™ Connectivity

Connect USB cable to PC Development Board
/ running Quick Start program
@ 814

- -%\- y Power Cable
ICD —2VDC B 115VAC

USB Cable / \
MPLAB® ICD 2 RJ-11 Cable
Connect RJ-11 cable to Apply power to the board

MPLAB® ICD 2

4. From the Debugger>Select Tool menu, select MPLAB ICD 2 as the debug tool.

5. From the Debuggermenu, select Connect. MPLAB should report that it found the
dsPIC30F6014 as shown in Figure 3-14.

Note: MPLAB may need to download new firmware if this is the first time the
MPLAB ICD 2 is being used with a dsPIC30F device. Allow it to do so. If
any errors are shown, double-click the error message to get more

information.
FIGURE 3-14: ENABLING MPLAB ICD 2
B Output =1aolx|
Build | Version Cantral | Find in Files MPLAR |'E:D.'2]
Connecting to MPLAB ICD 2 =]
_Connected ;

|Setting Ydd source to target

Target Device dsFIC30FE014 found, revision = Dxdl
..Beading ICD Froduct ID

Funning ICD Self Test

..Fassed

MPLAB ICD 2 Ready
-
[ | Llj

6. From the Debugger menu, select Settings to display the ICD Debugger settings
(see Figure 3-15).

7. Onthe Program tab, ensure that “Allow ICD 2 to select memories and ranges” is
selected. This setting will speed up programming by addressing only a small part
of the total program memory.
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FIGURE 3-15:

MPLAB ICD 2 DEBUGGER SETTINGS

Statuz | Communication I Limnitations I Fower I
Program Vergions I ‘Warnings
& Allow ICD 2 to select memaries and ranges
" Manually select memoriss and ranges
—fdemaries — Program D ptions
I™ Frogram ¥ Freeze on Halt
¥ Configuration F= Eras%ll before Frogram
I~ | EERROHM
=D
[~ Exterrial
= Frogran femarny External bemary
[hiex] =]
Sttart IUHU Start IDxD
End IUxU End |'JxD
Full Hangel Full Hangel
= Bootlnader
Izer Memony Foutines
I\IED2\IED2.INI Browse:. |
0k I Cancel | Lpply | Help |

8. Program the part (Debugger>Program). The Output window shows the results of

the programming cycle as shown in Figure 3-16. The part is now programmed

and is ready to run.

FIGURE 3-16: OUTPUT WINDOW
moup P [=IE
Buid | Version Contiol | Find in Files MPLABICD 2 |
i;lrglgil;]l;lgel"i I argetL.. ;I

..Programming Program Memory (0x0 - 0x1 ATF)
..Loading DebugExecutive

...Programming DebugExecutive I
...Programming Debug Yector

...Programming Configuration Bits

erifying...

...Program Memory

...Debug Executive

..Dehug Vector

Werify Succeeded

..Programming Configuration Bits

.. Config Memaory

erifying configuration memaory...

Connecting to debug executive

...FProgramming succeeded

MPLAE ICD 2 Ready

-

9. Runthe code (Debugger>Run). The program initializes and tests the peripherals,

as depicted in Figure 3-17. Note the responses on the dsPICDEM.net board as
the program executes. These responses are indicated along the right side of the
flow chart. The code modules are identified along the left side of the flow chart.
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FIGURE 3-17:

PERIPHERAL INITIALIZATION AND TEST PROGRAM FLOW

main.c

init_ports.s

init_timers.s

lcd.c

init_Sram.s

Display
SRAM FAIL

Initialize Ports &
W Registers

v

Initialize

Timers 1,2 &3
LEDS ILLUMINATE

v LED2 and LED3 BLINK

Initialize
LCD

v

Test
SRAM

Y SRAM TEST RESULT DISPLAYS

Display
SRAM PASS

init_RealTek NIC.c

Display
LOOPBACK FAIL

v

Initialize & Test |
NIC h

v

NIC
Loopback
Pass?

NIC TEST RESULT DISPLAYS

Display
LOOPBACK PASS

Yes

TestCAN.c

Display
LOOPBACK FAIL

init_uart.s

Initialize & Test P
CAN N

CAN TEST RESULT DISPLAYS

Loopback

Display
Pass? LOOPBACK PASS

testuartl.c

Display
LOOPBACK FAIL

f

No

Initialize & Test
UART1

Y UART1 TEST RESULT DISPLAYS
UART1
Loopback
Pass?

Display
LOOPBACK PASS

init DCI.s

init Si3021.s

Display

/FAIL Message

f

Initialize
DCI -

v

Initialize Si3021
DAA/AFE

4

FRAME LOCK STATUS DISPLAYS

Display
LOCK Message

Yes

init_INTpin.s

init_Spil.s

init Adc.s

Initialize INTx
Pins for Interrupt

v

Initialize
SPI1 Module

v

Initialize
ADC Module

RUNNING RP1 and RP2 VALUES DISPLAY

© 2004 Microchip Technology Inc.

DS51471A-page 43



PICDEM.net™ 1 and dsPICDEM.net 2 Connectivity Dev Board User’s Guide

At this point the program is running in the main loop (see Figure 3-18). The LCD
displays the current values of potentiometers RP1 and RP2:

RP1= 3.44v
RP2= 2.14v
FIGURE 3-18:

QUICK START PROGRAM MAIN LOOP

isr INTpin.s

isr INTpin.s

isr INTpin.s

(RUNNING)

) 4

INT1
Interrupt?
(81)

Yes Execute OFF-HOOK
’ and Display Message

S1 DEPRESSED

No
<

S2 DEPRESSED

Yes Execute ON-HOOK
and Display Message

INT3
Interrupt?
(S3)

S3 DEPRESSED

Yes Display

TEMPERATURE

No [«
v
Delay
delay.c 200 ms
display.s Call Display
bin2dec.c Conversion

v

ﬁ

isplay RP1 & RP2
Values

/

v

Dac_Update.c

Update
Digital Pot
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3.7 INTERACTING WITH THE CODE

With the program running you can interact with the peripherals on the dsPICDEM.net
board and observe the results on the LCD.

1.

Depress S1.
The LCD displays the message: Off_Hook mode.

In this mode, the dsPIC commands the Si3021 DAA/AFE to go off-hook and
seize the line (i.e., the typical routine for a modem to connect to the PSTN). For
this demonstration the dsPIC transmits a single tone to the AFE via the Data
Converter Interface module on the dsPIC device. After the off-hook routine is
completed the LCD reverts to the routine that displays the values of RP1 and
RP2. The tone continues to be generated and can be heard until switch S2 is
depressed.

Depress S2.
The LCD displays the message: Ready... On_Hook.

For this routine, the dsPIC commands the Si3021 DAA/AFE to go on-hook (i.e.,
the typical condition when a modem releases the telephone line). For this
demonstration the dsPIC terminates the data transfer from the Data Converter
Interface to the Si3021 AFE. After the on-hook routine is completed the LCD
reverts to the routine that displays the values of RP1 and RP2.

Depress S3.

The LCD displays the temperature as measure by sensor U2 followed by the
Ready... On_Hook message and then reverts to the RP1 and RP2 readings.

Touch U2 (located just left of the LCD) for a few seconds, then depress S3 again.
Notice the changed value of the temperature sensor.

Adjust RP1 and/or RP2.

Notice the changed value(s).

3.8 QUICK START DEMONSTRATION FEATURES AND PERIPHERALS

The intent of the Quick Start demonstration is to give you hands-on experience with the
dsPIC30F processor and peripheral features. At this point, you can examine the
program (main.c) and/or individual code modules in MPLAB IDE. You can set
breakpoints to examine specific activities. Or you can step through the code modules
one instruction at a time.

3.8.1 dsPIC30F Peripheral Features

The Quick Start demonstration program initializes and controls these dsPIC30F
peripherals and associated board functions:

Timer1 — Configured as a 16-bit timer with 1:1 prescaler used as toggle rate for
LED1.

Timer2 — Configured as 16-bit timer with a 1:1 prescaler used as toggle rate for
LED2.

Timer3 — Configured as 16-bit timer with a 1:1 prescaler used as toggle rate for
LEDS.

UART1 TX — Used to transmit demonstration data to the PC for display.

SPI™ 1 — Used to communicate to the MCP42050 Dual Channel Digital
potentiometer.

12-bit ADC — Used to convert multiple analog signals, such as potentiometer and
temperature values (TC1047A temperature sensor).
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» Data Converter Interface — Interfaced to an external Si303x DAA/AFE chipset for

PSTN interface control and monitor.
* INTx pins — Used for detecting switch S1-S3 inputs.

* PORTD pins, RD0-RD15 — Used to interface to 64Kx16 SRAM, 10-base T NIC

and 2x16 LCD.

3.9 DATA AND CONTROL FLOW

3.91 Power-up Sequence

Table 3-1 provides more details on the power-up peripheral initialization sequence

illustrated in Figure 3-17.

TABLE 3-1: POWER-UP PERIPHERAL INITIALIZATION SEQUENCE
Seq Module or. Board Initialization Process
Function
1 Timer1 Configured to count to 2.2 mS and reset.
2 Timer2 Configured to count to 3.95 mS and reset.
3 Timer3 Configured to count to 2.2 mS and reset.
4 2x16 LCD Initialization of 2x16 character LCD, via PORTD pins

RD0-RD15.

5 64Kx16 SRAM

Initialization and test of 64Kx16 SRAM, via PORTD pins
RDO0-RD15. Testing is performed by writing and reading back
a specific incrementing pattern.

6 10-base T NIC

Initialization and test of 10-base T NIC, via PORTD pins
RDO0-RD15. Testing is performed by performing internal
loop-back tests as supported by the NIC.

7 UART1
38400 baud.

The transmitter is configured for interrupt-driven operation at

8 Data Converter
Interface (DCI)

Configured for Slave mode. Configured to communicate to the
Si303x DAA/AFE chipset operating in Master mode. Some
DAA/AFE self test routines are executed.

9 External interrupt
pins INT1-INT3

Configured to interrupt on the falling edge and used for
switches S1-S3, respectively.

10 |SPI™ 1
Digital potentiometer.

Configured for communication with MCP42050 Dual Channel

11 12-bit ADC

Configured to continuously sample channels AN3
(temperature sensor U2), AN4 (RP1) and AN5 (RP2).

3.9.2 Main Loop Code Execution

Table 3-2 explains the step-by-step execution sequence of the Main Loop shown in

Figure 3-18
TABLE 3-2: MAIN LOOP CODE EXECUTION SEQUENCE
Seq. Program Task

1 Check state of variable “hook_status”, which is modified in either INT1, INT2 and

INT3 Interrupt Service Routines.

2 12-bit ADC collects a sample each from the digital potentiometer RP1 and RP2 and

temperature sensor, U2.

3 Data obtained from ADC is converted to ASCII for display by UART and LCD.

N

LCD is updated with Potentiometer RP1 and RP2 values.

5 SPI 1 transmit RP1 and RP2 values to dual channel digital potentiometer. Monitor of

potentiometer output is via PWO0 and PW1 test points on board.
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3.9.3 Interrupts Used in the Demonstration Program

3.9.3.1  EXTERNAL INTERRUPTS TO MAIN ROUTINE

External interrupts INT1-INT3 are controlled by switches S1-S3 respectively.

Each switch is monitored by the respective Interrupt pin, INT1-INT3. For each switch
detected the variable “hook_status” is modified in the ISR. The variable “hook_status”
is then monitored in the main loop and based upon the variable state one of three
actions are taken.

3.9.3.2 12-BIT ADC INTERRUPTS

The 12-bit module is configured to continually sample and convert channels AN3
(temperature sensor U2), AN4 (RP1) and AN5 (RP2). When all three signals have been
converted an ADC module based interrupt occurs and the ISR code simply saves off
the converted values to variables defined in data memory. Outside the interrupt this
“raw” data is converted to ASCII by a simple conversion routine and then used by the
UART and LCD display code modules.

3.9.3.3 UART TRANSMIT INTERRUPTS

Approximately every 200 mS, data is transmitted via the UART to the HyperTerminal
session window. The term “data” refers to the following:

» Analog data such as RP1 and RP2 voltages
» Temperature sensor data, U2

3.934 TIMER1

Timer1 is a 16-bit timer that uses the instruction cycle as its time-base. It is configured
to time out and generate an interrupt every 2.2 milliseconds. The Timer1 Interrupt
Service Routine (ISR) simply toggles LED1 and clears the associated interrupt flag.

3.93.5 TIMER2

Timer2 is a 16-bit timer that uses the instruction cycle as its time-base. It is configured
to time out and generate an interrupt every 3.95 milliseconds. The Timer2 Interrupt
Service Routine (ISR) increments a variable, tests bit 9 of this variable and if set toggles
LED2. If LED2 is toggled the ISR resets this same variable to zero. Finally the
associated interrupt flag is cleared.

3.93.6 TIMER3

Timer3 is a 16-bit timer that uses the instruction cycle as its time-base. It is configured
to time out and generate an interrupt every 2.2 milliseconds. The Timer3 Interrupt
Service Routine (ISR) increments a variable, tests bit 9 of this variable and if set toggles
LEDS. If LED3 is toggled the ISR resets this same variable to zero. Finally the
associated interrupt flag is cleared.
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3.10 SUMMARY

This quick start demonstration program is aimed at getting users more familiar with the
dsPIC peripherals and dsPICDEM.net Development Board functions. In working
through this demonstration you should also become more comfortable with features of
MPLAB IDE and the MPLAB C30 compiler and the use of the MPLAB ICD 2 debugger
with the dsPICDEM.net board.

After working with the Quick Start program you will have:

* Increased your understanding of how the dsPIC30F works with its peripherals.

» Gained a further understanding of how to initialize and control dsPIC30F
peripherals and associated board functions.

» Reduced the learning cycle for getting started with your development using the
dsPIC30F product family.
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Chapter 4. HTTP Web Server Demonstration

41 INTRODUCTION

This chapter describes a sample program that demonstrates Web-based monitoring
and control of an embedded application operating with the CMX-MicroNet TCP/IP
Stack configured for Hyper Text Transfer Protocol (HTTP) Web Server protocol.

4.2 HIGHLIGHTS

Information in this chapter includes:

» Demonstration Overview

» Demonstration Setup

» Configuring your Laptop or Desktop PC

» HTTP Web Server Demonstration

» Debugging TIPS

» Troubleshooting

» Using HTTP Web Server in Your Application

4.3 DEMONSTRATION OVERVIEW

This demonstration program runs on the dsPIC30F6014 using the CMX-MicroNet
TCP/IP Stack configured for HTTP Web Server protocol to support remote monitoring
and control of the application over an Ethernet connection.

The CMX-MicroNet TCP/IP Stack is designed for optimized use of Flash and RAM
Memory on dsPIC30F devices. This software runs directly on the processor with no
gateways or PCs required. The stack can be run in stand-alone mode or work in
conjunction with an RTOS. This demonstration uses approximately 4.2K instructions in
Flash and 300 bytes in RAM, not including the HTML, java applets and.jpg and.gif
images.

In this demonstration the dsPIC “serves-up” HTML pages to a browser and implements
two basic HTML form methods: GET and POST. The GET and POST methods are
demonstrated in the form of requests from and updates to the HTML page displayed
on a browser. These functions enable you to monitor and change functions on the
dsPICDEM.net board.

The GET method retrieves information from the potentiometers, temperature sensor
and switches to illustrate monitoring functionality. The POST method uploads
information to the LCD and LEDs on the board to illustrate control and updating
functionality. For this demonstration the HTML page served-up by the dsPIC device is
stored in the Flash Program Memory. Alternatively, the dsPICDEM.net board provides
a 24L.C515 Serial 1°C EE 64 Kbyte Memory device that can be used to store the HTML
pages.
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44 DEMONSTRATION SETUP

441 Equipment Requirements

The HTTP Web Server demonstration requires the following equipment:

» dsPICDEM.net Development Board Kit with dsPIC30F6014 Plug-in-Module (PIM)

» CAT-5 crossover cable (or standard Ethernet cable and access to a network or
hub)

* MPLAB IDE Integrated Development Environment
* MPLAB ICD 2 In-Circuit Debugger

 Laptop or Desktop PC with RS-232 serial port or USB port for connecting to the
MPLAB ICD 2 In-Circuit Debugger

* RJ-11 phone cable for connecting the MPLAB ICD 2 to the dsPICDEM.net board

4.4.2 Equipment Setup
Connect the dsPICDEM.net board to your PC or laptop as shown in Figure 4-1.

FIGURE 4-1: WEB SERVER DEMONSTRATION SETUP
PC running MPLAB® Connect board to PC with
IDE and Internet CAT-5 crossover cable
Explorer

dsPICDEM.net™ Connectivity

\ Ethernet / Development Board running
RN : :

connection web server demonstration

s |14

e o= Power Cable

115 VAC

Connect MPLAB® ICD 2
to PC with USB cable

\ Apply power to board

Connect MPLAB® ICD 2 to
board with RJ-11 phone cable

1. Connect the MPLAB ICD 2 to your PC with the USB cable.

2. Using the short RJ-11 phone cable, connect the MPLAB ICD 2 to RJ-11 modular

connector ICD on the board.

3. Connect one end of the supplied CAT-5 crossover cable to RJ-45 modular

connector J15 on the board and the other end to the Ethernet network card on
the PC or Laptop.

4. Connect the dsPICDEM.net power cable to the power input connector (J14).
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443 WEB Server Program Setup

Copy the WEB Server folder from the dsPICDEM.net Development Kit Software CD
to the c:\ drive on your PC or laptop (see Figure 4-2).

FIGURE 4-2: WEB SERVER DEMONSTRATION CODE

Copy WEB Server folder from
CDtoyourC:\ drive

= ) dsPICDEM. net Board Sample Applications
H () FTP Setver

> ey ® ) Guick Start
# [ Tutarial
[ I v22bis Soft-Modem e I e I Type l
o o [ I— et _
| Mewom : MRRRE (et : i
<~ -! giﬂgp@mg_._hgaj 180 KE HEX File

4.5 CONFIGURING YOUR LAPTOP OR DESKTOP PC

This HTTP Web Server demonstration is configured to operate with a Static IP address.
To run the demonstration program you must configure the local Network Connections
on your laptop or Desktop to use a compatible Static IP address.

Note: Before reconfiguring your network connection settings for this
demonstration, make a note of your current PC settings. You will want to
restore your original PC settings after you complete this demonstration.

To reconfigure your network connections, follow these steps:

1. From the Windows desktop, click Start>Settings>Network Connections> Local
Area Connection.

2. Right-click Local Area Connection and select Properties. The Local Area
Connection Properties dialog displays your current connections.

3. On the General tab, scroll down the list of connections to Internet Protocol
TCP/IP, then click Properties. The Internet Protocol (TCP/IP) Properties dialog
displays, as shown in Figure 4-3.

Note: Record your current settings so you can restore them later.

4. On the General tab, check Use the following IP address: and type in these

settings:
IP Address: | 216 . 233 . 5 . 32 |
Subnet mask: | 255 . 255 . 255 . 0 |

5. Check OK in each dialog box until you close all the windows. Depending on the
version of Windows you are running, you may be required to reboot your PC for
the changes to take effect.

6. Proceed with the HTTP Web Server demonstration.
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FIGURE 4-3: IP SETTINGS DIALOG
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4.6 HTTP WEB SERVER DEMONSTRATION

461 Programming the dsPIC30F6014 Device

The dsPIC30F6014 device must be programmed with the HTTP Web demonstration
program (webdemo . hex). If you have previously loaded this program on a
dsPIC30F6014 device you can proceed directly to Section 4.6.2 “Start HTTP Web
Server Session”.

1. Apply power to the board. The green POWER LED illuminates.

2. Launch MPLAB IDE on your PC. From the Configure menu, choose Select
Device, then select dsPIC30F6014.

3. Select Programmer>Select Programmer>MPLAB ICD 2. You should see a
connection message in the output window, as shown in Figure 4-4.

If the MPLAB ICD 2 does not initially connect and recognize the dsPIC30F6014
device, click the MPLAB ICD 2 puck icon on the MPLAB IDE toolbar.

The output window should then indicate a successful connection.

FIGURE 4-4: MPLAB ICD 2 CONNECTION MESSAGE WITH dsPIC30F6014
iu'—'tP“t _J_l»- Dﬂ
Build | Version Contial | Find inFiles MPLABIED 2 |
Connecting to MPLAB 1CD 2 =]
..Connected i

|Setting Ydd source to target

Target Device dsPIC30FE014 found, revision = Ox40
..Reading ICD Product ID

Funning ICD Self Test

.Passed

MPLAB ICD 2 Ready
-
4] | B
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From the MPLAB IDE File menu, select Import. Browse to the C:\WEB Server
directory where you saved the webdemo . hex file, select it and click Open.
From the MPLAB IDE Configure menu, select Configuration Bits and verify the
device configuration settings shown in Figure 4-5.

FIGURE 4-5: SETTING CONFIGURATION BITS IN MPLAB IDE
W Configurationses R
Lddress Value Category I Setting I|
FZZZZZ Clock S3witching and Monitor Sw Dizabled, Mon Disabled
Oscillator Source Primary Oscillator
Primary OQscillator Mode ZT w/PLL &8x
Fgo00z Watchdog Timer Dissbled
WDT Prescaler L 1:512
WDT Prescaler B 1:16
FS0o04 FFCF Haster Clear Enable Enabled
PECOR Enable Enabled
Brown Out Voltage 4,5V
POR Timer Value 64ms
FS000L FFFF General Code 3egment Code Protect Di=abled
General Code 3egment Write Protect Disakbled
Faooogc 4003 Contn Channel Select Use PGC/EMUC and PGD/EMUD

FIGURE 4-6:

From the MPLAB IDE Programmer menu select Program. The webdemo . hex
file downloads to the dsPIC30F6014. The Output Window records the process
as it occurs and indicates completion by displaying “MPLAB ICD 2 Ready”.
Remove the MPLAB ICD 2 cable from the board then press “RESET” on the
demonstration board to run the program. The LCD on the dsPICDEM.net board
indicates that the program is running, as shown in Figure 4-6.

LCD DISPLAY

CMX-MicroNet

WEB Server Demo
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4.6.2 Start HTTP Web Server Session

This demonstration is intended to run with Windows 98, NT, and XP using Internet
Explorer 5 or 6 or Netscape 4.7.

1. Launch your browser.
2. Type the following URL address:
http://216.233.5.31

The dsPIC30F6014 Web Server returns the HTML page shown in Figure 4-7.

FIGURE 4-7: WEB PAGE FROM dsPIC30F6014
F CMX MicroHet Demo - Microsoft Internet Explorer _ O] x!
File Edit *iew Favortes Took  Help |
S | @ 3 a2
Bach arsvard Stop Refresh  Home Sesrch  Favortes  History Prirt EXit
Address |@ hitpe 216233 5311 j s

W SYSTEMS ﬁ\“"‘"‘"“"“""’ ﬂsp ’B@

This WEB Page is Served by the dsPIC30F running the CMX-MicroNetmw.

CMX-MicroNet is an embeddable TCP/IP stack that is specifically designed for optimized use of FLASH and RAM resources
on Microchip's 16-bit Digital Signal Controller. The software runs directly on the processor with no gateways or PCs required.
The stack can be run in stand alone mode or work in conjunction with an RTOS. Using only industry standard protocols,
CMX-MicroNet offers true TCPIIP networking via Direct, Dial Up, or Ethernet connectivity. This demo is using approximately
4.2K instructions in Flash for code and 300 bytes RAM, not including the HTML, java applets, and and the jpg and .gifimages.

Enter up to 16 characters in the box, select update, and Press the LEDs button to flash the dsPICDEM.net™ board

observe the dsPICDEM.net™ board LCD LEDs
LEDs
Update |
JAVA APPLET

Turn RP1 and RP2 potentiometers, press switches S1, 52 and S3 or touch temperature sensor U2 on the dsPICDEM.net
board and see the results below.

RP1 RP2 Temperature S1 §2 Ss3
2.17 v 0.7V 28.3 °C off oOff off

Copyright © CMX Systems, Inc. 2003 All rights reserved |

If you encounter a connection problem refer to Section 4.8 “Troubleshooting”.
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4.6.3 Monitor the dsPICDEM.net™ Development Board

This demonstration shows how you might monitor devices used in your embedded

application program over an Ethernet connection (or over the internet). In this portion
of the demonstration you will monitor the voltage on potentiometers RP1 and RP2, the
temperature on sensor U12 and the status of switches S1, S2 and S3 (see Figure 4-8).

1. On the dsPICDEM.net board, adjust potentiometers RP1 and RP2. Observe the
associated voltage value changing on the web page.

2. Touch temperature sensor U2 and monitor the temperature displayed on the web
page.

3. Press switches S1-S3 and observe the switch indicators on the web page
change between Off (red) and On (green).

TEMPERATURE SENSOR U2
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4.6.4 Control the dsPICDEM.net™ Development Board

This portion of the demonstration illustrates how you can remotely control functions in
an embedded application from your browser. Information you enter on the web page
affects the LEDs and LCD display on the dsPICDEM.net board.

1. Repeatedly click the LEDs button on the web page. LED1, LED2 and LED3 on
the dsPICDEM.net development board toggle up and down in sequence for each
mouse click.

2. Enter up to 16 characters in the text box on the web page, then click the LCD
button.

The information you typed displays as line 2 of the LCD on the dsPICDEM.net
board.

3. Repeat step 2. The last typed entry replaces line 2 of the LCD.
FIGURE 4-9: CONTROLLED DEVICES
J g
'.-1_' | -lr'I]' 1

o R
=

|
. I-||ll-lll LEE4EE RN -
ro ==
Iz I
INFORMATION TYPED ON WEB PAGE
DISPLAYS ON LCD

-I
-
i~ T

4.6.5 Hyper Text Transfer Protocol

HTTP is the defacto standard for transferring World Wide Web documents, although it
is designed to be extensible to almost any document format. HTTP Version 1.1 is
documented in RFC 2068. HTTP Version 1.0 (deprecated) is documented in RFC
1945. See also the W3C'’s work on the standard at: www.w3.org/Protocols/.

HTTP operates over TCP connections, usually to port 80, though this can be
overridden and another port used. After a successful connection, the client transmits a
request message to the server, which sends a reply message back. HTTP messages
are human-readable. An HTTP server can be manually operated with a command such
as Telnet Server 80.

The simplest HTTP message is "GET url”, to which the server replies by sending the
named document.

In HTML, you can specify two different submission methods for a form. The method is
specified inside a form element, using the METHOD attribute. The difference between
METHOD="GET" (the default) and METHOD="POST" is primarily defined in terms of
form data encoding.
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4.7 DEBUGGING TIPS

Use a packet sniffer to monitor all the transmitted frames and observe exactly what is
going on in real-time (see Figure 4-10). A packet sniffer can be used with the PC-side
TCP/UDRP client/server test programs that are included with the MicroNet software. A
number of good packet sniffers are available as freeware.

Freeware Packet Sniffers for Windows include:

* AnalogX PacketMon (www.analogx.com)
* Anasil (www.sniff-tech.com)

+ CommView (www.tamosoft.com)

» Ethereal (www.ethereal.com)

» Sniffem (www.sniff-em.com)

Commercially available packet sniffers include:

* Klos Technologies' SerialView, PacketView (www.klos.com)
» Windows Packet sniffing library for C#, C++, VB (www.packet-sniffing.com)

For additional information on packet sniffers, refer to:

www.robertgraham.com/pubs/sniffing-faq.html

FIGURE 4-10: ETHEREAL FREEWARE PACKET SNIFFER
@ The Ethereal Network Analyzer B & ! Ellzj
File Edit Ca[}éure Display  Tools Help
Ma. . |Time ‘Source |Destinati0n |F'r0t0c:0| |Inf0 =
587 1004.917101 216.233.5.32 216.233.5.31  HTTP POST flcd_;'nsg HTTP,)’l.Il
588 1004.99716% 216.233.5.31 216.233.5.52 HTTP HTTR/1.0 204 WO Content
589 1004,997617 216.233.5.32 216.233.5.31  TCP 4173 » http [FIN, ACK] Seq=346
500 1005.045457 216.233.5.31 216.233.5.32 TCP http > 4173 [ACK] Seq=175116 A
501 1005.045676 216.233.5.31 216.233.5.32 TCP http > 4173 [FIN, ACK] Seq=1l735:
562 1005.045710 216.233.5.32 216.233.5.31 TCP 4173 » http [ACK] Seq=34637346
503 1005.632215 216.233.5.32 216.233.5.31 TCP 4174 » http [SYM] Seq=34639605
504 1005.681003 216.233.5.31 216.233.5.32  TCP http > 4174 [S¥YM, ACK] Seq=l75,
505 1005.681081 216.233.5.32 216.233.5.31  TCP 4174 » http [ACK] Seq=34639605
596 1005.682517 216.235.5.32 216.233.5.31  HTTP POST flash_LEDs HTTR/1.1
507 1007.573274 216.233.5.31 216.233.5.32 HTTP HTTR/1.0 204 Mo Content
5098 1007.5740950 216,233.5.32 216.233.5.31 TCP 4174 > http [FIN, ACK] Seq=346
500 1007.618605 216.233.5.31 216.233.5.32 TCP http > 4174 [ACK] Seq=175288 A —j,
fAn TAAT A1 00TA T e T3 B3 EEI L . ) - bkt v A1 P4 T amie]l s 1 7E
= I =
HFrame 1 (62 bytes on wire, 62 bytes captured) =
HEthernet II, src: 00:09:6b:90:4c:T9, Dst: 00:00:12:34:56:78
E Internet Protocol, src addr: 216.233.5.32 (216.233.5.32), Dst addr: 216.233.5.31 (21
B Transmission Control Protocol, Src Port: 4108 (4108), Dst Port: http (800, Seq: 3210
f

|- | B
0000 00 00 12 34 56 7B 00 09 &b 90 4c T9 08 00 45 00 .4vx.. k.L...E. '
0010 00 30 55 Shb 40 00 80 06 e9 5a d8 e% 05 20 dS e9 oufg... .Z... ..
0020 05 1f 10 0c 00 50 bf Sb &8 79 00 00 00 00 FO 020 ..., P.L hy....p
0030 40 00 d4e dc 00 00 02 04 05 b4 01 01 04 02 SMecoos o

£

Fier |

il Feset| Apply ‘ <live capture in progress =
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4.8 TROUBLESHOOTING

The HTTP Web Server program has been tested on a dsPICDEM.net connectivity
board like the one you have received. No problems have been encountered (hence
none expected when you run the demonstration).

The Java applets used in the HTTP Web Server program have been tested with
Internet Explorer 5 and 6 and Netscape 4.7 from Windows 98, NT, and XP platforms.
Depending on the Java settings in your browser, you may experience the following
error message when the browser begins communication with the dsPIC30F-based
Web Server and attempts to load the Java applet:

Loading class dsPICDEMO
Exception:java.lang.NullPointerException
To remedy this error condition, use this procedure:

Note: The exact steps may be slightly different depending on the version of Win-
dows, the browser type and browser version you are using.

1. Open the Internet Properties (XP) dialog box.
From your browser select Tools>Internet Options.

From Windows select Start>Settings>Control Panel>Internet
Options>Advanced.

Ensure that Java console enabled (requires restart) is selected (see
Figure 4-11). Click OK and allow the browser to restart.

FIGURE 4-11: BROWSER JAVA SETTINGS

Internet Properties 2| x|

Generall Securit_l,ll F'rivac_l,ll Eantentl Eunnectiunsl Programs  Advanced

Settings:

&] HTTP 1.1 seftings ]
Use HTTP 1.1
[ Use HTTF 1.1 through prasy connections

[Ej Microzoft Vi
Java conzole enabled [requires restart)
[ Javaloaging enabled
JIT compiler far virtual machine enabled [requires restart]

88, Mulimedia
O Con't display online media content in the media bar

Enable Autarnatic Imaage Resizing
Enable Image Toolbar [requires restart)
Flay animations in web pages

Play zounds in web pages

Play videoz in web pages

O 5how image download placeholders

Shaw pictures -
4| | b
Restare Defaults I

k. I Cancel | Apply |
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Next, go to Control Panel and select the Java Plug-in application. Open this application
and select the Cache tab. Ensure the “Enable Caching” box is deselected. Once
complete click on the Apply and close this control panel.

Retry the browser refresh function and see if the entire HTML page is now displayed
correctly.

FIGURE 4-12: JAVA PLUG-IN BROWSER SETTINGS

& Java{T™) Plug-in Control Panel - x|
['Basic | Advanced | Browser | Proxies | Cache | Certificates | About |

[_] Enable Caching

Cache Settings
Location 3

Size

Jar compression O

Hone High

Reset

4.9 USING HTTP WEB SERVER IN YOUR APPLICATION

Operating the dsPIC30F with the CMX MicroNet TCP/IP stack gives you the ability to
send data across the Internet. However, you must decide how to use it in your design.
If you are simply looking for an interactive method of monitoring real time values as they
are changing within your target device, you may want to utilize the HTTP protocol and
server already developed. By setting up a series of URLs or “links”, you can have the
HTTP module format the information in the form of HTML files.

If you require a more efficient or a secure form of interaction, you could set up a
proprietary method of communication and deliver it within the payload of the TCP
packet itself. A Windows application could be created in order to communicate, interact
and manage a group of your devices on the Net. One step further may be to give the
ability of the devices themselves to interact with each other.
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NOTES:
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Chapter 5. FTP Server Demonstration

5.1 INTRODUCTION

This chapter describes a sample program that demonstrates remote monitoring and
control of an embedded application using File Transfer Protocol (FTP) communication.

5.1 HIGHLIGHTS

Information in this chapter includes:

» Application Overview

» Demonstration Setup

» Configuring your Laptop or Desktop PC
» FTP Server Demonstration

* Summary

5.2 APPLICATION OVERVIEW

This demonstration program illustrates file transfers between an embedded application
on the dsPIC30F6014 and a remote computer. The embedded application uses the
CMX-MicroNet TCP/IP Stack configured as an FTP Server. The FTP server
“associates” system application data with a virtual file system implemented in the
dsPIC Flash memory.

Atypical dsPIC30F FTP application allows data files produced by the dsPIC device and
stored in the virtual file system to be retrieved remotely for such tasks as data logging,
inventory control, performance analysis, and more, on the remote computer system.
Some applications may update Program Flash on a remote dsPIC device from a central
server location. In other applications, FTP activity may execute on a scheduled basis
using automatic error detection/correction to ensure that data is properly transmitted
and received.

CMX-MicroNet FTP Server is fully compliant with Internet Engineering Task Force
(IETF) and Request for Comments (RFC) standards and supports Windows-, DOS-,
UNIX- and Linux-based FTP clients. For detailed information on these standards, refer
to: www.ietf.org/ and www.fags.org/rfcs/, respectively.

This sample application demonstrates two main activities supported by the
dsPIC30F6014 FTP Server:

+ Retrieving a file on the FTP server from an FTP client
» Transmitting data to the FTP server from an FTP client

This demonstration is set up to run with a Microsoft Windows FTP client or at the
command prompt.
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5.3 DEMONSTRATION SETUP

5.31 Equipment Requirements

This demonstration requires the following equipment:

» dsPICDEM.net Development Board Kit with dsPIC30F6014 Plug-in-Module (PIM)
» Crossover Cable (or standard Ethernet cable and access to a network or hub)

* MPLAB IDE Integrated Development Environment

* MPLAB ICD 2 In-Circuit Debugger

+ Laptop or Desktop PC with RS-232 serial port or USB port for connecting to the
MPLAB ICE 2 In-Circuit Emulator

* RJ-11 phone cable for connecting the MPLAB ICD 2 to the dsPICDEM.net board.

5.3.2 Equipment Setup
Connect the dsPICDEM.net board to your PC or laptop as shown in Figure 5-1.

FIGURE 5-1: FTP SERVER DEMONSTRATION SETUP
PC running MPLAB® IDE Connect board to PC with
and DOS Command CAT-5 crossover cable
Prompt

‘ dsPICDEM.net™ Connectivity
Ethernet /Development Board running

FTP Ssrver demonstration

USB Port connection
o
B J14
\' < Power Cable
ICD \QVDC 115 VAC
: \ Apply power to board
Connect MPLAB®ICD 2 =
to PC with USB cable Connect MPLAB™ ICD 2
to board with RJ-11 phone
cable

1. Connect the MPLAB ICD 2 to your PC with the USB cabile.

2. Using the short RJ-11 phone cable, connect the MPLAB ICD 2 to RJ-11 modular

connector ICD on the board.

3. Connect one end of the supplied CAT-5 crossover cable to RJ-45 modular

connector J15 on the board and the other end to the Ethernet network card on
the PC or Laptop.

4. Connect the dsPICDEM.net power cable to the power input connector (J14).
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5.3.3 FTP Server Program Setup

Copy the FTP server folder from the dsPICDEM.net Development Kit Software CD
to the C:\ drive on your PC or laptop (see Figure 5-2).

FIGURE 5-2: FTP SERVER DEMONSTRATION CODE

Copy FTP Server folder from
CD to your C:\ drive

5 pcomt I [Z) dsPICDEM. net Board Sample Apslieak | ,//
* i S EETE Sorver Mame = i Size | Tvpe
e w1 () Quick Start ﬁlftpdemnhex 107 KB HEX File
‘ ) Tukarial

I) ¥22bis Soft-Madem
) "WEB Server

5.4 CONFIGURING YOUR LAPTOP OR DESKTOP PC

The FTP server demonstration is configured to operate with a Static IP address. To run
the sample program you must configure the local network connections on your laptop
or desktop computer to use a compatible Static IP address.

Note: Before you reconfigure your network connection settings for this sample
program, make a note of your current PC settings. You will want to restore
your original PC settings after you complete the demonstration.

5.4.1 Network Connections

To reconfigure your network connections, follow these steps:

1. From the Windows desktop, click Start>Settings>Network Connections> Local
Area Connection.

2. Right-click Local Area Connection and select Properties. The Local Area
Connection Properties dialog displays your current connections.

3. On the General tab, scroll down the list of connections to Internet Protocol
TCP/IP, then click Properties. The Internet Protocol (TCP/IP) Properties dialog
displays, as shown in Figure 5-3. Make a note of your current settings so you
can restore them later.

4. On the General tab, check Use the following IP address: and type in these

settings:
IP Address: | 216 . 233 . 5 . 32 |
Subnet mask: | 255 . 255 . 255 . 0 |

5. Check OK in each dialog box until you close all the windows. Depending on the
version of Windows you are running, you may be required to reboot your PC for
the changes to take effect.

6. Proceed with the FTP Server demonstration.
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FIGURE 5-3:

IP SETTINGS DIALOG
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5.5 FTP SERVER DEMONSTRATION

5.5.1 Programming the dsPIC30F6014 Device

This exercise requires that the dsPIC30F6014 device be programmed with the FTP
demonstration program (ftpdemo.hex). If you have previously loaded this program on
a dsPIC30F6014 device you can proceed directly to Section 5.5.2 “Start FTP Server

Session”.

1. Apply power to the board. The green POWER LED illuminates.

2. Launch MPLAB IDE on your PC. From the Configure menu, choose
Select Device, then select dsPIC30F6014.

3. From the MPLAB IDE Debugger menu, choose Select Tool, then select

MPLAB ICD 2. You should see a connection message in the output window, as
shown in Figure 5-4.
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If the MPLAB ICD 2 does not initially connect and recognize the dsPIC30F6014
device, click the MPLAB ICD 2 puck icon on the MPLAB IDE toolbar.

The output window should then indicate a successful connection.

FIGURE 5-4: MPLAB ICD 2 CONNECTION MESSAGE WITH dsPIC30F6014
Bl Output E =T
Buid | Version Contiol | Findin Files MPLABICD 2 |
Connecting to MPLAB ICD 2 =
..Connected E

|Setting Ydd source to target

Target Device dsPIC30FE014 found, revision = Ox40
..Reading ICD Froduct ID

Funning ICD Self Test

..FPassed

MPLAS ICD 2 Ready
-
K | 2

4. From the MPLAB IDE File menu, select Import. Browse to c: \FTP Server and
open ftpdemo. hex.

5. From the MPLAB IDE Configure menu select "Configuration Bits” and verify the
device configuration settings shown in Figure 5-5.

FIGURE 5-5: FTP SERVER CONFIGURATION BITS SETTINGS
ol
Setcting
|=w Disabled, Mon Disabled i
FYIMSEYY USCLLLIaTOY
Primary Oscillator Mode ZT w/PLL 8x
Fa0o0o0oz T7FFF Watchdog Timer Dizabled
WDT Prescaler A 1:51z
WDT Prescaler E 1:16
Fso004 FFCF Master Clear Enable Enabled
PEOR Enshle Enshled
Erown Cut Voltage 4.5V
POR Timer Value G4ms
Fa000A FFFF General Code Segment Code Protect Dizabled
General Code Segment Write Protect Disabled
Fs000C 4003 Com Channel Select Tse PGC/EMUC and PGD/EMUD

6. From the MPLAB IDE Debugger menu select Program. The ftpdemo . hex file
downloads to the dsPIC30F6014. The Output Window records the process as it
occurs and indicates completion by displaying "MPLAB ICD 2 Ready’.

7. Press <F6> to reset the program, then press <F9> to run the program. The LCD
on the dsPICDEM.net board indicates that the program is running, as shown in
Figure 5-6.

FIGURE 5-6: LCD DISPLAY FOR FTP DEMONSTRATION

CMX-MicroNet

FTP Server Demo
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5.

5.2 Start FTP Server Session

After programming the demonstration into the dsPIC30F6014, follow these steps:

1.

2.
3.

If CMX-MicroNet FTP Server is not running, press <F6> (Reset) followed by
<F9> (Run).

From Windows, open a DOS command session.

From the command line prompt, type “ftp 216.233.5.31” to connect to the
dsPIC30F6014 FTP Server.

When the connection is made you will be prompted for your user name and
password.

For the user name type “cmx”.
When prompted for the password, type “password”.

Note: Both the user and password are case-sensitive. Be sure both entries are
lower case.

Upon successful sign-on you will have connected to the FTP Server running on
the dsPIC30F6014 device. You will see a transaction sequence similar to that
shown in Figure 5-7.

FIGURE 5-7: LOG ON FTP SERVER SESSION

mmand Prompt - ftp 216.233.5.31

icrosoft Windows HP [Uersion 5.1.2684A1
<C» Copyright 1985—23@1_"1::1-039!-'1: Corp.

C:nrftp 216.233.5.31
Connected to 216.233.5.31.

228
User €¢216.233.5.31:<{noned>: c
331

ggas""’"d . Successful connection

Successful sign-on

This screen shows when the connection is made and when the user is success-
fully logged on. This program only uses commands necessary to receive files
from and send files to the dsPIC30F device. For information on the command set
supported by CMX-MicroNet FTP Server, refer to the “FTP FUNCTIONS” section
of the CMX-MicroNet TCP/IP STACK Manual.
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5.5.3 Receive File From FTP Server

This portion of the demonstration shows how you might retrieve a file from the FTP

Server virtual file system in dsPIC30F6014 memory.

1. At the ftp> prompt, type “dir”.

2. The FTP Server returns a listing of the files in its virtual file system, as shown in
Figure 5-8.

FIGURE 5-8: RECEIVING A FILE FROM THE FTP SERVER

e Command Prompt - ftp 216.233.5.31

root sys index.htm
root sys pageZ _htm
root sys cmxlogo . gif
root sys about .gif
root sys bhenchmrk.gif
root sys contact._gif
root sys home .gif
root sys press.gif

received in B.31Seconds 1.6%9Kbytes sec.
“htm

226
Etp; 1148 bytes received in B.178econds 6.63Khytes/sec.
t

3. At the next ftp> prompt, type get index.htm.

As the file downloads, the DOS screen displays status milestones: command
received (200), file ready to send (150), and file transferring (226).

4. When the file transfer is complete, the status displays the number of bytes
transferred, how long it took, and the transfer rate achieved. At the next ftp>
prompt, type “quit” to close the FTP session, but leave the DOS session running.

5. In Windows, locate and view the transferred file using a graphics program (see
Figure 5-9). This file is located in the directory from which you ran the DOS
command FTP session (c:\).
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FIGURE 5-9: IMAGE OF TRANSFERRED FIL

/J CMx MicroNet Demo - Microsoft Internet Explorer — 3] %]

Ao | &

File Edit %ew Favorites Tools  Help

() Bark - O - IiLI @ _:‘J | /_‘SEar(h \j‘;{Favuntes A edia é"“ =
Address (&7 Cilindex htm =l B ‘Lmks ”|®Snaglt (=8

e

This page is coming from CMX-MicroNet.

a

CMX-MicroNet can do more than just display HTML pages. Forms can be used to send data to the web server
where the data can then be acted upon by user-defined functions.

<I—#exac cgi= =
Subimit
The buttons below don't do anything. They are here to show that multiple graphics files can be mcluded in web
pages.
EIEIEEE

Go to Page 2
Copyright © CMX Systems, Inc. 2003 All rights reserved

E

€

[ [ Hy Computer

5.5.4 Send a File to FTP Server

This portion of the demonstration shows how you might transfer a file to the embedded
application. The demonstration process is conducted in three parts. First you create a
file on your PC to transfer to the dsPIC30F6014 FTP Server. Next you open an FTP
session and transfer the file. And finally, you use MPLAB IDE to examine the actual
contents of the FTP virtual file memory on the dsPIC30F6014 device.

To create the demonstration file to be transferred:
1. Atthe DOS command line prompt, type “notepad”.
2. When Notepad displays, type the following message:
“This is a test file to demonstrate the dsPIC30F6014 FTP Server.”
3. Save the message as c:\testdemo.txt.
To transfer the demonstration file:
1. Open another FTP session (see Section 5.5.2 “Start FTP Server Session”).
2. Atthe ftp> prompt, type “put testdemo.txt”.

As the transfer progresses, milestones are displayed sequentially. When the file
transfer is complete, the status displays the number of bytes transferred, how
long it took, and the transfer rate achieved.

3. At the next ftp> prompt, type “dir” to verify that the file is now in the FTP server
virtual data memory. The listing shows that the file is included, as shown in
Figure 5-10.
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FIGURE 5-10: FTP SEND DEMONSTRATION SESSION

nmand Prompt - ftp 216.233.5.31

sys 252 Jan 1 2883 contact.gif
1 root sys 218 Jan 1 2883 home.gi
—p——p——p—— 1 root sys 288 Jan 1 2863

: 526 bytes received in B.165econds 3_37Kbytes/sec.
put testdemo.txt

: 63 bytes sent in B.BBSeconds 63808_A0Kbhytes-sec.

-

index.htmn

page2  htm

cmxlogo . gif
if

root

root

root sSYs
root sSyYs
root sSYs
root sSyYs
root sSYs
root sSyYs
root sYs

press . gif
testdemo.txt

o
P

received in B._345econds 1._73Kbytes/sec.

4. Atthe ftp> prompt, type “quit” to end the FTP session. Then type “exit” to close
the DOS command prompt.

5. Go to MPLAB IDE and press <F5> to halt the FTP Server program in the
dsPIC30F6014.

To examine FTP Server memory:

1. In MPLAB IDE select View > File Registers. The File Registers window displays
the contents of the FTP Server virtual file.

The information displayed in red represents new data in FTP Server memory.
Information related to this demonstration starts around address location 0x850.

2. Page down the File Registers window to until you see the values displayed in red.
Examine the ASCII data to look for the file name (testdemo. txt) in the ASCII
area, as shown in Figure 5-11.

FIGURE 5-11: FTP VIRTUAL FILE DIRECTORY ENTRY
T =
dddress | oo | oz | o2 | os | o8 | oa | oc | oE | ASCIT |~
10C0 0000 0000 0000 0000 0000 0000 0000 5551 weveeeer evonn. Qu

10Dpo 5445 0000 0000 0000 0000 0000 0000 0000 IT...... wevuwons
10EDQ o000 0000 0000 0000 0000 0000 3239
10F0 OooL 0000 0000 0000 0000 o000 000 L
1100 6EES ©564 ZE7S 7465 O06D 0000 0000 0000 index.ht - --- =g
1110 oooo 0000 0OEi10 DCAR 0000 0052 6574 T4YI ... ... R A
1120 6564 6FeD 74ZE Y478 0000 0000 0000 0000 demo.txt ........
1130 0040 0000 Z212Z2C 000% 0000 0000 0000 0000 B...,!'.. cevuvann
1140 Qooo 0000 0000 0000 0000 0000 0000 0000 .. eeeee wevanaas
1150 0000 0000 0000 0000 0000 0000 0000 0000 ... ... wevennn-
1160 0000 0000 0000 0000 0000 0000 0000 0000 ... e e wevnnnns
1170 Qooo 0000 0000 0000 0000 0000 0000 0000 ... eevee wevanaas ﬁg

[ Hew  Symbolic | s¢v Data

3. Next, scroll down to the next block of red data (approximately at address
0x2000-0x2100). Examine the ASCII area to find the content of the
testdemo. txt file, as shown in Figure 5-12.
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FIGURE 5-12: FILE CONTENT RECEIVED BY FTP SERVER
Il File Registers ' i 10| x|
iddress I 0o | 0z i 04 | 06 | o8 | oL | oc | o | LSCIT [~

2000 0000 0000 0000 0000 0000 ESDE 2005 ESDE  .ovvever wvnee ..
20E0 1FOS 0000 3412 7856 OEO0 Gomfemiof tostdems o iV - - -k-8
20F0  FFFF FFFF OOFF 06ce oved o0 | .. e
2100 0000 0000 6170 7373 EFTH bss word. ...
2110 0000 0000 0OOO0 0000 0000 0000 0000 0000 el
2120 0000 0000 0000 FFFF FFFF 0042 6854 7369 fooveven. .. E.This
2130 6920 2073 2061 6574 7473 6620 6Ce9 2065 | is a te =t file
2140  6F74 6420 6D65 GEGF 7473 6172 6574 7420 fro demon strate t
2150 6568 £420 5073 4349 3033 3646 3130 2034 Jhe dsPIC 30Fs014
2160 5446 2050 6553 <T672 7265 432E O1BE 0000 JFTP Serv er.c....
2170  FE31 L146 730D 4FAD SEDL 501 ASTF GFG5 ' em—
2180  DDS5 044C FBEE EA16 DEAE D31E 7TFE5S 223E ..L..v.. oo..2.3M

| Hex Symb-:-licl ><1’Data|

4. In MPLAB, close the workspace and exit the program.

5.6 SUMMARY

This demonstration has illustrated the basic capability of the dsPIC30F6014 functioning
as an embedded FTP Server.

As stated in Section 5.2 “Application Overview” an embedded FTP server may be
suitable in such applications such as data logging, inventory control, remote system
performance analysis and remote reprogramming of the dsPIC Program Memory
Flash, just to mention a few. The FTP Server uses the TCP/IP protocol layer, which
ensures an ordered reliable delivery of the data.

The Program Memory Flash and Data RAM resources requirements for the
CMX-MicroNet Stack is presented in Table 5-1.

TABLE 5-1: RESOURCES FOR THE CMX-MICRONET STACK

Flash

UDP/IP + Core 4470 bytes
TCP/IP + Core 7827 bytes
UDP/TCP/IP + Core 8685 bytes
PPP 6681 bytes
Modem 447 bytes
HTTP Server 3888 bytes
Virtual File 885 bytes
Ethernet 2652 bytes
DHCP Client 2202 bytes
FTP Server 3657 bytes
TFTP Client 723 bytes
BOOTP 684 bytes
SMTP 1918 bytes
Utility 1314 bytes
RAM (not including buffer sizes)

UDP/SLIP 56 bytes
TCP/HTTP/PPP 304 bytes
Ethernet 38 bytes
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Chapter 6. V.22bis Soft Modem Demonstration

6.1 INTRODUCTION

This chapter describes the dsPIC30F Soft Modem demonstration running on the
dsPICDEM.net Development Board. The demonstration software is a subset of the
dsPIC30F data modem library offered by Microchip. The dsPIC30F data modem library
is composed of ITU-T compliant algorithms for V.21, V.22, V.22bis, V.23, V.32 and
V.32bis modem recommendations and Bell standard 103. The dsPIC30F data-modem
included as part of the dsPICDEM.net Connectivity Development Board and
demonstrated in this section supports V.22bis and all lower data pump modulations.
Full source code for V.22bis and lower data pump modulations is provided on the
dsPICDEM.net Development Kit Software CD. V.32bis is not part of this demonstration
package but is available for purchase.

For detailed information on the soft modem refer to the dsPIC30F Soft Modem User’s
Guide provided on the dsPICDEM.net Development Kit Software CD.

6.1 HIGHLIGHTS

Information covered in this chapter includes:

» Demonstration Overview

» Demonstration Configurations

* Demonstration Procedures

» Reprogramming the dsPIC30F6014

* Description of dsPIC30F Soft Modem

+ dsPIC30F Soft Modem AT Command Set

» Troubleshooting the Connection

» Regulatory Compliance Reference Information
* ITU-T Specifications

6.2 DEMONSTRATION OVERVIEW

This demonstration illustrates the ability of the dsPIC30F Soft Modem to connect to
another modem for transmitting and receiving data over the PSTN. The demonstration
program implements real-time ITU-T V.22bis Transmit and Receive Data Pump
Modulations. For specific information related to key features and performance metrics
for the dsPIC30F Soft Modem see Section 6.6 “Description of dsPIC30F Soft
Modem”.

© 2004 Microchip Technology Inc. DS51471A-page 71



PICDEM.net™ 1 and dsPICDEM.net 2 Connectivity Dev Board User’s Guide

Some possible applications implied by this demonstration include:

+ POS Terminals

+ Set Top Boxes

» Drop Boxes

» Fire Panels

* Internet-enabled home security systems

* Internet-connected power, gas and water meters
* Internet-connected vending machines

» Smart Appliances

* Industrial Monitoring

6.3 DEMONSTRATION CONFIGURATIONS

The soft modem demonstration is set up to run either as a pair of dsPIC30F devices
running the soft modem and connected end-to-end, or as a dsPIC30F device
communicating with a remote terminal equipped with a standard reference modem.

The LEDs and switches on the dsPICDEM.net board are not used for the soft modem
demonstration.

6.3.1 Equipment Requirements

The soft modem demonstration requires the following equipment:

» dsPICDEM.net Development Board for originate/answer modem

» dsPICDEM.net Development Board or standard reference modem for
answer/originate modem

» PC or laptop for configuring and controlling dsPIC30F soft modem(s) via AT
commands

» PC or laptop for configuring and controlling standard reference modem via AT
commands

* Analog phone line for each originate and answer modem

* RJ-11 phone cable for each dsPICDEM.net board and standard reference modem
(not provided)

Note: Connect dsPICDEM.net to an analog line only. Using a non-analog line
(e.g., digital, PBX Multi line) may damage the modem.

6.3.2 Selecting the Demonstration Configuration

Figure 6-1 illustrates the set-up configuration for operating the end-to-end soft modem
demonstration. This configuration requires the modem software on both
dsPICDEM.net boards. The soft modem is controlled by AT commands entered on the
Windows HyperTerminal (or suitable alternative terminal emulator) running on the PC
or Laptop. This demonstration requires two analog phone lines, one each for the
originate and answer modems.
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FIGURE 6-1: END-TO-END DEMONSTRATION SET UP

PC running Windows
HyperTerminal

PC running Windows
Analog HyperTerminal
Telephone
Exchange
RS232 or TAS

T o

.

e N/

dsPICDEM.net™ Connectivity
Board running Soft Modem

Figure 6-2 illustrates the set-up configuration for the interoperability soft modem
demonstration. With this configuration, one terminal is the dsPIC30F running the soft
modem. The other terminal is a PC or laptop with a standard reference modem. (See
Section 6.8.1 “Standard Reference Modems” for a list of tested reference modems).
The soft modem is controlled by AT commands entered on the HyperTerminal or
suitable terminal emulator program running on a PC or laptop. The other terminal is
controlled by the terminal emulator on the opposite PC or laptop. This demonstration
requires two analog phone lines, one each for the originate and answer modems.

FIGURE 6-2: INTEROPERABILITY DEMONSTRATION SET UP

PC running Windows

HyperTerminal PC running Windows

Analog HyperTerminal
Telephone
Exchange
RS232 or TAS
m] 4 Xg
L \/\/ Standard

RJ-11 Reference Modem
dsPICDEM.net™ Connectivity /

Board with Soft Modem
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6.4 DEMONSTRATION PROCEDURES

Follow these steps to exercise the soft modem functionality in real time. The
dsPIC30F6014 device plugged into the dsPICDEM.net board has been
pre-programmed with the V.22bis data-modem for this demonstration. If the
demonstration program has been replaced by another application, you will need to
reprogram the dsPIC30F6014 (see Section 6.5 “Reprogramming the
dsPIC30F6014” for instructions on programming the soft modem into the dsPIC).

6.4.1 Initialize the Hardware

1. Configure the demonstration for end-to-end operation, as shown in Figure 6-1,
or interoperability, as shown in Figure 6-2.

2. Make sure the 2x2 shunts on J17 and J19 are inserted in vertical alignment
(perpendicular to the LCD display)

3. Apply power to the dsPICDEM.net Board(s) and/or the standard reference
modem.

4. Press and release the RESET switch located to the right of the LCD.
The LCD acknowledges that the soft modem is initialized, as shown in Figure 6-3

FIGURE 6-3: LCD DISPLAY

dsPIC30F V.22bis
Soft-Modem Demo

6.4.2 Configure the Terminal for dsPIC30F Soft Modem

These procedures assume, but do not require, that you are using the Windows
HyperTerminal.

1. Start HyperTerminal on both PCs. If you are set up for interoperability and are
using a standard reference modem on one terminal, consult the modem user
manual for specifics on configuring the modem.

2. Configure HyperTerminal with these settings:

Bits per second = 19200

Data bits = 8
Parity = None
Stop bits =1

Flow Control = Hardware
Set the Comm Channel appropriately for each PC.
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3. Execute these AT commands on each HyperTerminal and note the response.

Command* Response
AT<ENTER> OK
AT&F<ENTER> OK
ATXO0 OK
ATS0=1 OK

*Refer to Section 6.7 “dsPIC30F Soft Modem AT Command Set” for descriptions of
AT commands supported.

6.4.3 Initiate Communication

At this point, the dsPIC30F Soft Modem is ready to establish a dial connection with
another modem.

1. Initiate dialing with the following AT command:
ATD<dial string>
where <dial string> indicates the telephone number of the remote soft modem.
By default, ‘auto answer after one ring’ is enabled. The remote soft modem
answers the call after one ring and connects in V.22bis and V.42 (LAPM) Mode.
ITU-T Recommendation V.42 contains a High Level Data Link Control (HDLC)
protocol referred to as Link Access Procedure for Modems (LAPM) and defines

error-correcting protocols for modems The following result codes are displayed
on both the Hyper Terminals upon a successful connection.

CARRIER 2400
PROTOCOL LAPM
CONNECT 19200

You should hear the call negotiation and training sequence on the call progress
speaker. If you are using a standard reference modem on one terminal, the con
nection message transmitted and displayed on the PC may be slightly different
but should present this same basic information. See Section 6.8.6 “Response
Messages for Successful Modem Connections” for an example of a
connection message provided by a USR 5686E type modem.

2. With the two modems connected, test data transfer by typing information on one
terminal and verifying that the same data is displayed on the other terminal.

3. Test file transfer by creating a brief text file and using following file transfer
options on the HyperTerminal.

HyperTerminal>Transfer>Send Text File
HyperTerminal>Transfer>Capture File

4. Repeat the test procedure for the other modulation protocols by executing the
following AT commands:

Protocol Command
V.22bis-2400 bps AT+MS=2,0,300,2400
V.22bis-1200 bps AT+MS=2,0,300,1200
V.23 bps AT+MS=3,0,300,1200
V.21 bps AT+MS=0,0,300,300
Bell 103-300 bps AT+MS=1,0,300,300
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5. You may need to reset and reconfigure the standard reference modem for
enabling these specific data modulations. Consult the standard reference
modem user’s manual for this information.

An example of configuring a USR modem for V.21 and V.23 is presented in
Section 6.8.4 “V.23 Connection Between dsPIC30F Soft Modem and US
Robotics Modem” and Section 6.8.5 “V.21 connection Between dsPIC30F
Soft Modem and US Robotics Modem”

6.5 REPROGRAMMING THE dsPIC30F6014

Should you need to reprogram the dsPIC30F6014 device begin by copying the
PC-Based Soft Modem folder from the dsPICDEM.net Development Kit Software CD
to the C:\drive on your PC or laptop (see Figure 6-4).

FIGURE 6-4: PC-BASED SOFT MODEM DEMONSTRATION CODE

Copy V.22bis Soft Modem
folder from CD to your C:\
drive

N GePICDEM et = |2y dsPICDEM.net Board Sample Applications | V
* it ot 1) FTP Server 7 ERE T
P .T y _Mame = ize pe
» B (2D Quick Start + [Efvazbisdemo hex : 1. HEXFile
O Tukerisl PP SRR
o IRl - 2 his Soft-Modem
s — ) WEB Server
-

The easiest way to get the soft modem demonstration up and running is to program the

provided .hex file into the dsPIC device using this procedure:

1. Apply power to the board. The green POWER LED illuminates.

2. Launch MPLAB IDE on your PC. From the menu bar select Configure>Select
Device>dsPIC30F6014.

3. Select Programmer>Select Tool>MPLAB ICD 2. You should see a connection
message in the MPLAB IDE output window, as shown in Figure 6-5.

If the MPLAB ICD 2 does not initially connect and recognize the dsPIC30F6014
device, click the MPLAB ICD 2 puck icon on the MPLAB IDE toolbar. The output
window should then indicate a successful connection.

FIGURE 6-5: MPLAB ICD 2 CONNECTION MESSAGE WITH dsPIC30F6014
N Output E =10l x|
Build | Version Contiol | Find in Files MPLAB ICD 2 |
Connecting to MPLAE 1CD 2 =]
..Connected |

Setting Wdd source to target

Target Device dsPIC30FE014 found, revision = 0x40
.Reading ICD Product 1D

Running ICD Self Test

..Fassed

FMPLAE ICD 2 Ready
iy o
i | | >
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From the MPLAB IDE File menu, select Import. Select Vv22bisdemo.hex and
click Open.

From the MPLAB IDE Configure menu, select Configuration Bits and verify the
device configuration settings shown in Figure 6-6.

FIGURE 6-6: CONFIGURATION BITS WINDOW
Bl Configuration Bits i =10 x|
Address |Ualue JCategDry |Setting
FSoooo C3oe Clock Switching and Monitor |SW Disabled, Mon Disabled
Oscillator Source Frimary USCclllator
Primary Cscillator Mode ZT w/PLL 8x
Fgoooz Qo3F Watchdog Timwer Dizabled
WDT Prescaler A 1:512
WDT Frescaler b 1:16
FE0004 8703 MNaster Clear Enable Enahled
PEOR Enable Lizakbled
Browh Out Voltage 4,5V
POR Timer Value 64m=
FSO00OL Qoo? General Code Secmwent Code Protect Disabled
General Code Segment Write Protect Disabled
Fgoooc coo3 Comrn Channel Select Uze PGC/EMUC and PGD/ENUD
4| | r

6. From the MPLAB IDE Programmer menu select Program. The
V22bisdemo.hex file downloads to the dsPIC30F6014. The Output Window
records the process as it occurs and indicates completion by displaying “MPLAB
ICD 2 Ready”.

Remove the MPLAB ICD 2 cable from the board then press RESET on the
demonstration board to run the program. The LCD on the dsPICDEM.net board
indicates that the program is running, as shown in Figure 6-7.

FIGURE 6-7: LCD DISPLAY

dsPIC30F V.22bis
Soft-Modem Demo

At this point you are ready to run the soft modem demonstration, as described in

Section 6.4 “Demonstration Procedures”.
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6.6 DESCRIPTION OF dsPIC30F SOFT MODEM

The Microchip data modem library includes ITU-T compliant algorithms for V.21, V.22,
V.22bis, V.23, V.32 and V.32bis modem recommendations as well as Bell standard 103.

These are the important parameters:

» V.21, V.23 and Bell 103 are Frequency Shift Keying (FSK) modems.

* V.32, V.32bis and V.22bis are Quadrature Amplitude Modulated (QAM) modems.
* V.22 is a Phase Shift Keyed (PSK) modem.

* V.21, V.22, V.22bis, V.32 and V.32bis are two-wire, full-duplex modems.

» V.23 is full-duplex when it operates with a 75-bps backwards channel.

» V.22bis includes fallback to V.22, V.23 and V.21 standards.

* V.32bis optionally falls back to V.22bis, V.22, V.23 and V.21 standards.

These key parameters are further detailed in Table 6-1.

TABLE 6-1: SOFT MODEM FEATURES AND PERFORMANCE

Performance Memory® (Kbytes)
Algorithm(") Data Rate | Half/Full Data MIPS

(bps) Duplex | Modulation | ro9ram | Data
V.21/Bell 1034 300 Full FSK 13 1.0 45
V.22/V.22bis ;42188 Full PSK/QAM 22 1.7 7
v.23(4 ! 620000 Half FSK 15 1.0 45
V.32 2288 Full QAM/TCM 31 3.2 12

14400

1200
v.32BIS 9600 Full QAM/TCM 36 3.6 15

7200

4800
V.42 n/a 14 2.0 15
DP + V.42 API n/a 7 1.2 -
AT Command Set n/a 7 0.15 -

Note 1: Data pump modules, V.21, V.22, V.22bis, V.23, V.32, V.32bis and Bell 103 are
implemented in Assembly language. V.42, Data Pump and AT Command APls are
implemented in C language.

2: The program/data memory usage for the V-series data pumps is NOT cumulative,
due to the sharing of components internally.

3:  Memory size does not account for application which combines data pump, V.42 and
AT commands (if required).

4: V.21/Bell 103 and V.23 data pumps do not require V.42.
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6.7 dsPIC30F SOFT MODEM AT COMMAND SET

The AT commands listed in Table have been selected to serve embedded soft modem
applications on the dsPIC30F product family. These commands are a subset of the
overall AT command set. Although the command set includes support for up to V.32bis,
only V.22bis is supported in this demonstration.

TABLE 6-2:

AT COMMAND SET FOR dsPIC30F SOFT MODEM

Command

Description

En

Command Echo
EO — Inhibits the echoing of commands to the computer
E1 — Echoes commands to the computer

Hn

Hang Up And Hook Control

H — Modem hangs up and go on-hook.
HO — Causes the modem to go on-hook
H1 — Causes the modem to go off-hook

Ln

Control Speaker Volume
LO — Speaker Turn off

L1 - Low
L2 — Medium (Default)
L3 - High

Information and Identification

This command has various options which are used to instruct the modem to
provide specific information about itself

10 — Displays the modem controller firmware revision

I3 — Same as 10

14 — Current modem settings

16 — Link diagnostics

Quiet Mode

Determines whether the modem sends result codes and status codes
(OK, BUSY, RING, etc.) to the terminal.

QO - Display result codes, user sees command responses (e.g., OK)
Q1 — Result codes are suppressed, user does not see responses

Vn

Result Code Form

Selects whether the modem sends long form (in words) or short form
(numeric) result codes the terminal.

V0 — Numeric result codes

V1 — English result codes (e.g., CONNECT, BUSY etc.)

Answer
Modem goes off hook, transmits answer tone and waits for a carrier
response from the remote modem.

Dnnn..

Dial

Dials a telephone number and attempts to connect. The dial command must
be the last command on the line.

To cancel the Dial command, press any key.

To dial 5588257, type ATD5588257

Local Loop Back
Modem Starts Local loop back

On

Enter Connect State and Retrain
00 - Leave online command mode and return to online data mode.
01 - Issues the retrain command
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TABLE 6-2:

AT COMMAND SET FOR dsPIC30F SOFT MODEM (CONTINUED)

Command

Description

Wn

Negotiation Progress Message Control

W0 — CONNECT result code reports DTE speed; disable the display of all
extended result codes.

W1 — CONNECT result code reports DTE speed, enable the display of
CARRIER and PROTOCOL extended codes only.

W2 — CONNECT result code reports DCE speed; disable the display of all
the extended result codes.

Xn

Dial Tone And Busy Tone Detection

X0 — Busy detect and dial tone detect disabled

X1 — Busy detect and dial tone detect disabled

X2 — Busy detect disabled and dial tone detect enabled
X3 — Busy detect enabled and dial tone detect disabled
X4 — Busy detect and dial tone detect enabled

&F

Modem Reset
Restore settings to defaults (Modem reset).

&Kn

Modem Flow Control

This command determines how the flow control between the computer and
the local modem is handled.

&KO0 - Disable local flow control

&K3 — Enable RTS/CTS (Hardware) flow control (default)

&K4 — Enable XON/XOFF (Software) flow control

&Qn

Communication Mode
Q5 — Modem negotiates an Error-corrected link (default)
Q6 — Selects asynchronous operation

+MS_1,2,3,4,

Select Modulation

+MS=<mod>,<automod>,<minrate>,<maxrate>

Where,

<mod> - Is specified modulation

<automod> - Enables the auto mode operation. This mode is always
enabled.

<minrate> - Sets the lowest modem speed

<maxrate> - Sets the highest modem speed

<Mod> Modulation Possible Rates (bps)
0 V.21 300
2 V.22bis 2400 or 1200
3! V.23 1200
9 V.32 9600 or 4800

By default V.32-9600 mode is selected and V.22bis/V.23/V.21 modes can be
selected by the following commands respectively

V.32bis-14400 bps
V.32bis-12000 bps
V.32bis-9600 bps
V.32bis-7200 bps
V.32-9600 bps
V.32-4800 bps
V.22bis -2400 bps
V.22bis-1200 bps

- AT+MS=9,0,300,14400
- AT+MS=9,0,300,12000
- AT+MS=9,0,300,9600
- AT+MS=9,0,300,7200
- AT+MS=8,0,300,9600
- AT+MS=8,0,300,4800
- AT+MS=2,0,300,2400
- AT+MS=2,0,300,1200

V.23 bps - AT+MS=3,0,300,1200

V.21 bps - AT+MS=0,0,300,300

Bell 103 -300 bps - AT+MS=1,0,300,300

Note 1: For V.23, originating mode transmits at 75 bps and receives at

1200 bps. Answering mode transmits at 1200 bps and receives
at 75 bps.
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TABLE 6-2: AT COMMAND SET FOR dsPIC30F SOFT MODEM (CONTINUED)

Command Description
S-Registers
These registers are used set some of the simple modem configurations.
ATSn=x Command writes the value X’ to the specified S-register (n).
ATSn? Command displays the value of S-register (n)
S0 Ring to Auto-answer On

Sets the number of rings required before the modem answers.
Auto answer ring count.
Default Value: SO = 1

S1 Ring Counter
Counts and stores the number of rings from an incoming call.
S6 Wait Before Dialing

Sets the number of seconds the modem waits for dial tone before dialing.
Default Value S6 = 1

S7 Wait for Carrier After Dial/Answer

Sets the number of seconds the modem waits for a carrier or answers
before returning on-hook and sending a NO CARRIER result code.
Default Value S7 = 60

S91 Transmit Signal Level
This register is used to specify the transmit signal level in —dBm value.
Default Value S91 = 12 (-12 dBm)

+++ Escape Sequence
This is a three character escape code used to enter into the command
mode from the data mode.

6.8 TROUBLESHOOTING THE CONNECTION

The dsPIC30F Soft Modem has undergone multiple levels of testing, ranging from
extensive bench testing using standard, off-the-shelf reference modems to full ITU-T
compliance testing. The reference modems used in the testing are listed in Table 6-3.

Reference modems are not all equal in terms of data pump (DP) modulations they
support as power-on default. For example, the US Robotics External 56K modem,
model 5686E, supports V.21 and V.23, but only if it is enabled via suitable AT
commands. Attempts to connect with V.21 and V.23 will fail until these DP modulations
have been enabled.

Also the US Robotics External 56K modem, model 5686E, does not support V.32 9600
bps (NTCM). The modem will disconnect after the rate exchange sequence during the
V.32 hand shake, since this is an invalid speed setting in V.32 mode. It connects at
9600 bps (TCM) in V.32bis mode.

This troubleshooting section does not address every specification or operational
feature of the reference modems. It is intended to be a starting point should you
experience some basic connection issues.
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6.8.1 Standard Reference Modems

The dsPIC30F Soft Modem has undergone extensive testing to ensure ITU-T
compliance and robust system operation. During performance and interoperability
testing, the reference modems listed in Table 6-3 were used in both the originate and
answer modes while communicating with the dsPIC30F Soft Modem on the
dsPICDEM.net Connectivity Board.

TABLE 6-3: REFERENCE MODEMS

Reference Modem Model Description

U.S. Robotics 5686E External V.90/V.92 56k Fax/Modem

U.S. Robotics 0839 External Sportster 33.6 Fax/Modem

U.S. Robotics 98117203 External Sportster Voice 33.6 Fax/Modem
Zoom 2949 External V.90 Fax/Modem

Zoom 3049 External V.92 Fax/Modem

D-Link DMF-336/E External 33.6 Fax/Modem

D-Link DMF-560/ES External 56k Data/Fax/Voice Modem
3Com 455630-01 External 56k Fax/Modem

6.8.2 ITU-T V.8 Support

Currently the dsPIC30F Soft Modem falls back to other modulations only through V.8
handshake. Therefore the dsPIC30F Soft Modem will not be able to establish a
connection in any DP modulation mode with reference modems that do not support the
V.8 handshake.

For example, D-Link and Zoom reference modems do not support the V.23 modulation
selection through V.8 handshake when they are in originating mode. Therefore the
dsPIC30F Soft Modem in answer mode will not be able to establish a V.23 connection
with these reference modems. However in answer mode, these reference modems do
support the falling back to V.23 modulations through V.8 handshake. Therefore the
dsPIC30F Soft Modem in originate mode is able to establish a V.23 connection with
these reference modems.

6.8.3 Data Flow Control

By default, the dsPIC30F Soft Modem uses hardware flow control for data transfer. The
dsPIC30F Soft Modem uses the UART flow control pins (RTS & CTS) on the
dsPICDEM.net connectivity board. This configuration requires that a two-position shunt
be installed in the vertical position on jumpers J17 and J19. Also, it is necessary to
enable the hardware flow control in HyperTerminal (or other terminal emulation
program running on the PC).

Itis possible to change the flow control mode of the dsPIC30F Soft Modem to Xon/Xoff
by using a specific AT command (AT&Kn) and selecting a corresponding flow control
mode in the HyperTerminal.
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6.8.4 V.23 Connection Between dsPIC30F Soft Modem and US
Robotics Modem

Following are AT commands for enabling V.23 between the dsPIC03F Soft Modem and
US Robotics Model 5686E Reference Modem. If the AT command is valid,
HyperTerminal displays 'OK' as the response message. If the AT command is invalid or
unsupported, HyperTerminal displays 'ERROR' as the response message.

Supported AT commands for V.23 connection on US Robotics Modem:

AT Command Function

AT&F1 Enable factory default settings
ATS0=1 Enable auto answer after one ring
ATS27=16 Enable the V.23 fallback

AT commands for V.23 connection on dsPIC30F Soft Modem:
AT Command Function

AT&F dsPIC30 Soft Modem default settings

AT+MS=3,0,300,1200 Force V.23 connection

6.8.5 V.21 connection Between dsPIC30F Soft Modem and US
Robotics Modem

Following are AT commands for enabling V.21 between the dsPIC30F Soft Modem and
US Robotics Model 5686E Reference Modem. If the AT command is valid,
HyperTerminal displays 'OK' as the response message. If the AT command is invalid or
unsupported, HyperTerminal displays 'ERROR' as the response message.

Supported AT commands for V.21 connection on US Robotics Modem:

AT Command Function

AT&F1 Factory Default settings

ATS0=1 Enable auto answer after one ring

ATS27=1 Enable the V.21 fallback

Supported AT commands for V.21 connection on dsPIC30F Soft Modem:
AT Command Function

AT&F Enable dsPIC30F Soft Modem default settings

AT+MS=0,0,300,300 Force V.21 connection

Note: In almost all the modems, a V.42 LAPM connection is not supported for
V.21 and V.23 data pump modulation modes. Hence a connection will be
established in Non-V.42 mode (PROTOCOL NONE).
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6.9

6.8.6 Response Messages for Successful Modem Connections

Table 6-3 lists connection messages displayed on the HyperTerminal when a
successful modem connection has been established between the dsPIC30F Soft
Modem and the US Robotics Model 5686E modem using the V22bis demonstration.

TABLE 6-4: SUCCESSFUL CONNECTION RESPONSE MESSAGES

Data Pump Modulation

dsPIC30F Soft Modem

US Robotics Model 5686E

V.22bis 2400 bps

CARRIER 2400
PROTOCOL LAPM
CONNECT 19200

CONNECT 2400/ARQ/LAPM

V.22 1200 bps

CARRIER 1200
PROTOCOL LAPM
CONNECT 19200

CONNECT 1200/ARQ/LAPM

V.23 1200 bps

CARRIER 1200/75
PROTOCOL NONE
CONNECT 19200
(dsPIC30F Soft Modem is the
answer modem)

CONNECT 75/1200/NONE
(USRobotics is the originate
modem)

CARRIER 75/1200
PROTOCOL NONE
CONNECT 19200

CONNECT 1200/75/NONE
(USRobotics is the answer
modem)

(dsPIC30F Soft Modem is the
originate modem)

V.21 300 bps CARRIER 300 CONNECT
PROTOCOL NONE
CONNECT 19200

Bell 103 TBP TBP

REGULATORY COMPLIANCE REFERENCE INFORMATION

Every country has telecommunication laws that prohibit the connection of unapproved
telecommunication devices, including modems, to the phone line. Approval by a
country's telecommunications regulatory agency may entail hardware/firmware
modifications to your end-system modem in order to comply with telecommunication
laws. Approval could require modifications for radio-frequency interference, pulse dial
make/break ratios, redial capabilities, and so forth.

The words "approved or compliant for use in country XYZ" mean that the modem has
been modified to comply with the telecommunication laws of that country. An American
modem approved by the Federal Communications Commission (FCC) in the United
States and imported to Germany would not be a legal telecommunications device in
Germany. FCC approval in the USA does not imply BZT approved in Germany.

The Silicon Laboratories chipsets used with the dsPICDEM.net 1 and dsPICDEM.net 2
Connectivity Boards are compliant with FCC, Japan Approval Institute for
Telecommunications Equipment (JATE) and Common Technical Regulation (CTR_21)
country-specific Post, Telephone & Telegraph (PTT) specifications. The chipsets can
be fully programmed for AC termination, DC termination, ringer impedance and ringer
threshold, enabling the devices to meet worldwide telephone line interface
requirements. The devices interface directly to standard modem DSPs or system
interface circuits.
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6.9.1 Federal Communications Commission

The Federal Communications Commission (FCC) rules (47 C.F.R. Part 68) governs the
direct connection of Terminal Equipment (TE) to the Public Switched Telephone
Network (PSTN), and to wireline carrier-owned facilities used to provide private line
services.

6.9.2 Industry Canada DOC CS-03

Approval of equipment for Canada is relatively straight-forward. Testing and
compliance should be in accordance with technical standard CS-03. The requirements
are well harmonized with FCC part-68. In many instances it is possible to use FCC
reports to obtain Industry Canada DOC CS-03 approval.

For additional information on FCC part-68 and approved test facilities refer to
www.fcc.gov.

6.9.3 Common Technical Regulation CTR-21

CTR-21 is a Common Technical Regulation that defines a harmonized standard for
analog access to the PSTN throughout the European Economic Area (EEA) and
Switzerland. In the past, analog standards were not harmonized. Manufacturers were
required to go to each country and test analog equipment to that country's unique
specifications. CTR-21 simplifies this process by enabling manufacturers to go to one
test lab and take one compliance test for all EEA member countries. The result is faster
product delivery throughout the EEA market.

6.9.4 Japan Approval Institute for Telecommunications Equipment

JATE is the institute that approves telecommunications equipment for use with Japan's
public telephone network. Approved equipment bears a JATE approval mark or
number. For more information on JATE refer to: www.jate.or.jp/index_e.html or Nippon
Telegraph and Telephone (NTT) Corporation: www.ntt.co.jp/index_e.html.
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6.10 ITU-T SPECIFICATIONS

Table 6-5 lists the ITU-T specifications used for development of the soft modem and
DTMF implementation on the dsPIC30F product family

TABLE 6-5: ITU-T SPECIFICATIONS

ITU-T Specification Name Of The Document

ITU-T V.32bis A duplex modem operating at data signalling rates of up to 14400
bit/s for use on the general switched telephone network and on
leased point-to-point 2-wire telephone-type circuits.

ITU-T V.32 A family of 2-wire, duplex modems operating at data signalling
rates of up to 9600 bit/s for use on the general switched telephone
network and on leased telephone-type circuits.

ITU-T V.22bis 2400 bits per second duplex modem using the frequency division
technique standardized for use on the general switched telephone
network and on point-to-point 2-wire leased telephone-type
circuits.

ITU-T V.21 300 bits per second duplex modem standardized for use in the
general switched telephone network.

ITU-T V.23 600/1200-baud modem standardized for use in the general
switched telephone network.

ITU-TV.8 Procedures for starting sessions of data transmission over the
public switched telephone network.

ITU-T V.25 Automatic answering equipment and general procedures for
automaticcallingequipmentonthe general switchedtelephone
network including procedures for disabling of echo control devices
for both manually and automatically established calls.

ITU-T V.42 Error-correcting procedures for DCEs using
asynchronous-to-synchronous conversion.

ITU-T V.56bis Network transmission model for evaluating modem performance
over 2-wire voice grade connections.

ITU-T V.56ter Test procedure for evaluation of 2-wire 4 kHz voice band duplex
modems.

ITU-T Q.23 Technical features of push-button telephone sets.

ITU-T Q.24 Multi-frequency push-button signal reception.
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Chapter 7. dsPICDEM.net Development Hardware

7.1 dsPICDEM.net Hardware Components

Figure 7-1 illustrates the major components that comprise the dsPICDEM.net
Development Board. Table 7-1 identifies these hardware elements and points to the
specific instructions for using each item.

FIGURE 7-1: dsPIC30F6014 16-BIT SIGNAL CONTROLLER HARDWARE
COMPONENTS

Ik
1

'|
T

[

TABLE 7-1: dsPICDEM™ net DEVELOPMENT BOARD HARDWARE

No. Hardware Element No. Hardware Element
1 CAN Port (Section 7.1.2) 12 | LCD Graphic Display (Section 7.1.9)
2 10-Base T Ethernet (Section 7.1.12) 13 | Temperature Sensor (Section 7.1.4)
3 Oscillator (Section 7.1.18) 14 | PSTN Telephone Interface (Section 7.1.11)
4 Emulation Header (Section 7.1.15) 15 | Power On Indicator (Section 7.1.17)
5 Sample Devices (Section 7.1.21) 16 | Power Supply (Section 7.1.16)
6 Prototyping Area (Section 7.1.20) 17 | RS-232 Serial Port (Section 7.1.1)
7 64kx16 External SRAM (Section 7.1.14) 18 | Serial EE Memory (Section 7.1.13)
8 Push Button Switches (Section 7.1.6) 19 | RS-485/RS-422 Port (Section 7.1.3)
9 Reset Switch (Section 7.1.19) 20 | Digital Potentiometer (Section 7.1.8)
10 |LEDs (Section 7.1.7) 21 | ICD 2 Connector (Section 7.1.10)

11 | Analog Potentiometers (Section 7.1.5)
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711 RS-232 Serial Port

A single RS-232 serial communication channel is provided on the dsPICDEM.net
Development Board. This serial communication channel, labeled J5, can be configured
as an RS-232 or RS-485/RS-422 communication channel via jumpers J17, J18 and
J19. The following jumper connections are required for RS-232 serial communications:
» J19, shunt pins 1-2 for Tx channel support

+ J19, shunt pins 3-4 for Rx channel support

» J17, shunt pins 1-2 for Request-to-Send (RTS) support

+ J17, shunt pins 3-4 for Clear-to-Send (CTS) support

Note: The shunts for J17 and J19 must be connected vertically.

» J18, shunt pins 2-3 for Rx connection to the dsPIC device

Jumper 19 connects the dsPIC UART channel 1 U1RX and U1TX pins to an RS-232
level shifting IC, U7. The serial port is configured as DCE, and can be connected to a
PC using a straight-through cable. If hardware handshaking is required, inserting
shunts on jumper J17 will connect CTS and RTS to port pins RA9 and RA10 on the
dsPIC device. These pins can support CTS/RTS through a bit-bang control approach.
Both pins are connected to IC U7.

71.2 CAN Port

The CAN RXD and TXD lines of the MCP2551 are connected to the dsPIC CANRX and
CANTX pins. CAN bus signals, CANH and CANL, are available on the DB9 connector
J4. The CANH and CANL bus can be locally terminated with a 120 ohm by inserting
jumper, J3.

71.3 RS-485/RS-422 Port

Signals for the RS-485/RS-422 port are available on the 6-pin terminal block labeled
TB1. The terminal block is configurable from RS-485 to RS-422 by removing the
jumper on J2. Inserting jumper J1 will terminate the bus with a 120 ohm resistor.

The RX485 and TX485 lines of the MAX489E can be tied to the dsPIC UART channel 1
U1RX and U1TX pins by the following jumper settings:

» J19, shunt pins 1-2 for Tx channel support
» J19, shunt pins 3-4 for Rx channel support

Note: The shunts for J19 must be connected vertically.

+ J18, shunt pins 1-2 for Rx connection to the dsPIC device

MAX489E receiver and driver output enables are controlled by port pins RGO and RG1,
respectively.

71.4 Temperature Sensor

This is a -40°C to +125°C linear output temperature sensor (TC1047A) connected to
analog channel AN3 of the dsPIC device. The output of the temperature sensor, U2, is
fed through a second order low-pass filter before connection to the dsPIC device. The
LP filter cutoff frequency is set at 10 Hz. The output voltage range for the TC1047A is
typically 750 mV at +25°C. The TC1047A exhibits a typical 10 mV/C voltage slope.
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7.1.5 Analog Potentiometers

Two 5 kOhm potentiometers are connected to analog channels AN4 and AN5. The
voltage output range for each potentiometer is between 0 VDC and 5 VDC. The voltage
source is provided by VR1, through a low-pass filter. VR1 is the main voltage regulator
for all components on the development board.

7.1.6 Push Button Switches

Three switches, S1-S3, are connected to port pins RA12-RA14, respectively on the
dsPIC device. The signal lines are normally pulled up to +5 VDC through 10 kQ2
resistors. Pressing the switch will short the line to ground. Port pins RA12-RA14 are
configured as the INT1-INT3 external interrupt pins.

71.7 LEDs

Three red LEDs, LED1-LED3, are connected to port pins RC2 to RC4, respectively on
the dsPIC device. The LED anodes are tied to VDD through a 1.2K resistor.

71.8 Digital Potentiometer

A dual channel digital potentiometer, MCP42050, is provided on the development
board. Control of the digital potentiometer is via the dsPIC SPI 1 communication
channel. The outputs of the digital potentiometer are applied to test points PW0 and
PW1.

71.9 LCD Graphic Display

A 2 x 16 character dot matrix LCD display is provided on the development board. The
dsPIC device accesses the LCD via PORTD pins RD0-RD7. The three LCD control
signals, RS, RW and E are connected to dsPIC port pins RA6, RB11 and RA7
respectively.

7.1.10 ICD Connector

By way of the modular connector ICD, the MPLAB ICD 2 can be connected for low-cost
programming and debugging of the dsPIC device. Programming and debugging the
dsPIC device is through dedicated use of the PGC/EMUC/RB1 and PGD/EMUD/RBO
pins on the development board.

7.1.11  Public-Switch Telephone Network (PSTN) Interface

The dsPICDEM.net Development board is available in 2 configurations, one using the
Si3035 chipset for the FCC and JATE compliant designs and the other using Si3034
chipset for worldwide applications.The dsPIC communicates with this port with its Data
Converter Interface (DCI).

The Si3035 chipset is composed of the Si3012 DAA and a Si3021 AFE ICs. The dsPIC
communicates to the Si3021 AFE via its DCI peripheral module.The Si3034 chipset is
composed of a Si3014 DAA and the same Si3021 AFE.

A speaker is provided on the development board and provides for call progress
monitoring.

For detailed operation, please refer to the Si3034 and Si3035 data sheets available on
www.silabs.com.

© 2004 Microchip Technology Inc. DS51471A-page 89



PICDEM.net™ 1 and dsPICDEM.net 2 Connectivity Dev Board User’s Guide

7.1.12 10-Base T Ethernet

An Ethernet interface is provided using the Realtek RTL8019 ethernet controller. This
is accessed via the bidirectional bus on PORTD. For detailed operation of this device
please see the RTL8019 data sheet from Realtek
» STATUS LEDs: Four LEDs are provided:

- LINK STATUS — This LED can be used for link status.

- XMIT and RX — When the board is connected correctly, these are normally lit,
and flash OFF (inverted logic), when the board is transmitting or receiving a
packet (respectively).

- BNC — This LED is enabled as default and indicates medium type.
Connection to the Ethernet is supported via the RJ-45 modular connector.

7.1.13 Serial EE Memory Device

A Microchip 24LC515 serial EEPROM provides 512 Kbit (64 Kbyte) of storage for
constants such as Web pages, linearization tables for sensors and custom data tables.
The 24LC515 is programmable via a two-wire serial I°C™ interface.

7.1.14 64k x 16 External SRAM

A Cypress 1 Mbit (64k words) CY7C1021B CMOS Static RAM is provided and can be
used to store temporary data for product development or diagnostic purposes. The
CY7C1021B is accessible via a multiplexed bus on PORTD pins RD0-RD15. The
SRAM control signals, CE, OE and WE are provided by the dsPIC PORTB pins RB9,
RB10 and RB11 respectively.

Two 74HCT573 Octal D-latches are implemented for latching the SRAM address. The
high and low byte control signals, BHE and BLE, of the SRAM are tied to ground,
through zero ohm resistors. Reads and writes to the SRAM are performed in the x16
data mode.

The following is a typical sequence of steps for accessing the external SRAM device:
Place 16-bit address on PORTD and set pin direction (TRISD) as outputs

Assert ALE (RB12) to a logic ‘1’ from a logic ‘0’ to latch address

Assert control signal OE (RB10) to a logic ‘0’ for a read or logic ‘1’ for a write
For a write, place data on PORTD

Assert CE (RB9) to a logic ‘0’ to select SRAM chip

If performing a read, read data on PORTD

If performing a write, assert control signal WE (RB11) to a logic ‘1’ from a logic ‘0’
8. Assert control signal CE (RB9) to a logic ‘1’ to deselect the SRAM

No gk wh =

7.1.15 Emulation Header

Headers J10-J13 provide for a connection to the MPLAB ICE 4K In-Circuit Emulator.
The emulation headers also support the processor adaptor boards (see Section
7.1.21 “Sample Devices”). The processor adaptor boards enable quick change out of
the 80-pin TQFP device.
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7.1.16 Power Supply

The dsPICDEM.net Development Board is powered by a +9V AC/DC wall adapter. A
single +5 VDC regulator provides all board components with +5 VDC. Analog
components are sourced from this same regulator through a low-pass filter circuit.
Separate analog and digital ground planes are connected through a single point.

Jumper J6 allows the supplied power source to be bypassed and an alternate supply
to be provided.

7.1.17 Power-on Indicator

A green LED is connected to the input of the regulators to indicate the presence of
power.

7.1.18 Oscillator

+ Crystal oscillator (7.3728 MHz) supplied.

» Thru holes and pads provided for user furnished watch-type crystal and two
capacitors for SOSC1 and SOSC2.

» Socket and pads for an output pull up resistor for user furnished crystal oscillator
to processor.

» External clock connections from J8.

TABLE 7-2: OSCILLATOR SELECTIONS

Oscillator Selection on Modifications on dsPICDEM™

Crystal R61, R62, R67, C42, C41 and XTAL2 open, U16 empty.
Crystal in XTAL3, caps in C40 and C39.

Mini Crystal R67, R61, R62, C40, C39 and XTAL3 open, U16 empty.
Crystal in XTAL2, caps in C42 and C41.

Canned Oscillator R67, R61, R62, C42, C41, C40, C39, XTAL2 and
XTAL3 open, U16 installed.

RC R61, R62, C42, C41, C40, XTAL2 and XTAL3 open,
U16 empty. Cap in C39 and resistor in R67.

External Clock R67, C42, C41, C40, C39, U16, XTAL2 and XTAL3
open. 0 ohm installed for R61 and R62.

7.1.19 Reset Switch

This switch is tied to the MCLR pin on the dsPIC controller, and is used to reset the
device.

7.1.20 Prototyping Area

A prototyping area and associated header are provided which enables additional ICs
and attachment boards to be added.

7.1.21 Sample Devices

A sample dsPIC device programmed with the demonstration code is included in the
dsPICDEM.net Development Board Kit. The 80-pin TQFP is soldered to a 1.5” x 1.5"
adaptor PCB which is inserted onto the emulation header, J11 and J13-J15. Careful
device handling should be used for inserting and extracting the adaptor board.

The orientation of the adaptor board is important. The Microchip logo and device part
numbering should be aligned to read from left to right before the insertion of the adapter
board.
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NOTES:
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Appendix A. Hardware Schematics

A.1 BOARD LAYOUT AND SCHEMATICS
A1.1 dsPICDEM.net 1 and dsPICDEM.net 2 Development Board

The following figures show the parts layout (silk screen) and schematics for the
dsPICDEM.net 1 and dsPICDEM.net 2 Development Board.
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dsPICDEM.net™ DEVELOPMENT BOARD LAYOUT

FIGURE A-1
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dsPICDEM.net™ DEVELOPMENT BOARD SCHEMATIC (SHEET 1 OF 11)

FIGURE A-2
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dsPICDEM.net™ DEVELOPMENT BOARD SCHEMATIC (SHEET 2 OF 11)

FIGURE A-3
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FIGURE A-4
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FIGURE A-5
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FIGURE A-6
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FIGURE A-7
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FIGURE A-8
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FIGURE A-9
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FIGURE A-10
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FIGURE A-11
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FIGURE A-12

<

REU.

DG N

11 40 11 Ei 7 SNIMMMG TWOS 10N 00 NOLLUOTedu
a Z01+v11 . No a3sn AssH LXaN aNay
vz 6/910-€0 o ow ou upsa| 57 o st aare
dds80dg 0W3a ¢ =Y l3ADIdsP 205,45 Sson a zs b4 8z b1 €8 z1 or or ang
. Nitbsg
adyod OW3a 1 ¥=Ul3A0IdsP -SIE3l 02 s 21°9 68 11 oz 0z NS+
JIHIOYD L ETC] ERCICEET xmw
"3NT TONIEALI8dNNGH % 7591 STTONY STUILOA ST Lok €20 220 122 2€0 630 620 889 499
ONIH3IaINIONT Jd314I1s43anIa “on 190minos Joat i ts e T g TEMI S 81N sIn 8In grn 10 €1n zin J1
1SI7 Siydd
[ CERER N eovaHon_ [ B [ T E anay
sz aany
€ ST 2 8 8 z 1€ 11 02 15 aN9
b El b1 + + € ze z1 12 8+ NS+
650 850 250 190 550 +S0 8+0 €50 Zs0 150 850 452
Ell 2n sn en 2rn 9n stn sin sin sin stn a1
€S | HOLIMS
sin‘In| ezn o1
T ’ . ’ bty Z8H S3d
nes nes nes nes nes nes nes nes nes nes e RER
nat nst nat Nt ante ante anTe ant anTe anTe ante ante El
oot Soot oot 292 650 8s0 250 oE 62 b o2 s 9% ST ANt
T T T srfisr | sIr NNOD
nas ed 3qo1a
$20 EES)
a3sn | a3sn
10N | LsH1 W3LI
> HOLENOIS3Id 43
nst nes nes nes nes nes nes nes nes nes nes
v anTe ante ante ante anTe ante ant ant ant anTe
mmuWH ssJ |  ¥s3 |  €s3 |  zs3 | 153 [ @s3 | €23 ]  z2T | 123 893 [
NS+
. iz
=
3
nes nes =
e ante ante E ngt
Sro =~ &I 183 ey
T Al £
894 +
43M0d
aany
pq0orie
Pw 1. HNBY ca [N
Qo ERl IS
= sr +N
NOTLDANNOD wop1
aany
ERBINIES % i
43n08ddy i 3180 i NOILd143530 i ‘aL oz adng
SNOISIN3Y

DS51471A-page 105

© 2004 Microchip Technology Inc.



PICDEM.net™ 1 and dsPICDEM.net 2 Connectivity Dev Board User’s Guide

NOTES:

DS51471A-page 106 © 2004 Microchip Technology Inc.



dsPICDEM.net™ 1 AND dsPICDEM.net 2

MICROCHIP

CONNECTIVITY DEVELOPMENT BOARD

USER’S GUIDE

Index
A CAN POrt ... 88
ANalog DEVICES .........cocvriiciricicicccce s 9 Digital Potentiometer............coocceennieennnsses 89
Emulation Header ...........ccccoeeiiiiiiiiiiiiee e 90

B ICD CONNECLON .....eiiiiiiiiiiee e 89

Board Hardware............cccoeciiiiiieeineeeec e 9 LCD Graphic Display ........cccccooeeeiiiieiiiieiiieenne 89

C LEDS ..ottt 89

Oscillator Options........cccccoeeciiieeiieiieee e, 91

CAN Channel .........oooiiiiiiiiie e 8 Power Supply ____________________________________________________ 91

Crossover Cable ... 8 Power-on INiCator ... 91

Customer Notification Service..........cccccoviieniiiiines 5 PrOtOtYPING A€ ..o eeeeeee e 91

CUStOMEr SUPPOIt.....ooiiiiiieiiii e 6 Push BUtton SWItCheS .. v 89

D Reset Switch ... 91

RS-232 Serial Ports .........coooiiiiiiiiiieeieee 88

DataPand Control Elow ........ s 46 RS-485/RS-422 Port ... 88

ower-up Peripheral Initialization ..................... 46 .

Demonstration Setup S_ample Dgwces ................................................ 91
TULOHAN orrre e eereee e eees e eeneee e 23 Si3000 Voice-band COdC .....oovrrvvvvrssvve 89,90
WED SErver......oooieiiie e 50 TEMPErature SeNSOr..........coocvvvrrersssssssv 88

Development Board Features |
10-Base T Ethemnet............ccoovvonvvvvviiinivinnns 9 INtErface Cable...........vveeureeerrreeesseeeeeseseeeeseeee 8
ANAIOG DEVICES .......oooveiininnees 9 Internet Address...........ccocrvrriirecinciineiec e 4
Device Clocking .......cccuveiveiiiiiiiiee e 9
MPLAB ICD 2 Connection L

MPLAB ICD 2 Connection ..........c.ccceeevveenne 8 Language Toolsuite...........cccccevrnieeiiieeciece 15, 34
MPLAB ICE4000 Connections LCD e e 10
MPLAB ICE 4000 Connection ..................... 8 LCD Display
Power Supply Circuit .........ccccoveviiireiieeeeeeen. 8 FTP Server Demonstration ..............ccccceeeeens 65
Serial Communication Channels......................... 8 Web Server Demonstration...........cccccceeeveennee. 53
Voice-band COdec .........ccovueeeiiieeiiiiieniee e 9 LED

Development Board Layout ...........ccceeeviiiiiiienineenn. 94 POWEI-ON ..ottt 8

Development Board Schematic............cccccocveeinnenn. 95 LED INdicators.......ccccuviiiiiieiiiieeiec e 10

Devlopment Board Features Link Status LEDS.........cueiiiiiiiee e 9
PTSN L 9 Low-Pass Filter ... 9

Digital Potentiometers..........ccccooiiiiiiiie 9

Documentation M
UPGALES vvoveeeeeeeeeee e eeee e eseeseeseeneees 2 Microchip Web Site .........cooiiiiiii e 4

MPLAB ICD 2.t 11

E MPLAB ICE 4000 ...........oveeiomeeeeoeeeeoeeeeeeeeeesseee. 8

Emulation Header .........coccoiiiiiiinii e 8 MPLAB ICE User's Guide ........ccoccvveneeeiiieeeiiieens 11

External SRAM .........cooiiiiiiicee e 10 MPLAB IDE User's Guide .........ccoceeeeieeeciieeeeiecee. 4

F (0]

Free Software Foundation .............cccccoeeiiveeiiinnnenn. 4 OVEIVIEW ...ttt 13

FTP Server Demonstration FTP Server Demonstration ..........c.ccccccveeeeeennes 61
LCD DiSPlay ......cevveerreeeirieeeniie e 65 Web Server Demonstration...........c..ccceeeverenee 49
OVEIVIEW ... 61

P

G Packet Sniffers ... 57

GNU Language TOOIS .......cccueeeiieiiiiiiia e 4 Power SUPPIY ...coeiiiiiiiee e 8

H Project ....ooo oo 13,32

Project Wizard.............ooo oo 13, 32

Hardware Board Components Prototyping Header ............ccooeveeeeeeeeeeeeeeeen 10

Analog Potentiometer Input ............cccccooeiieeee. 89 PTSN oo 9

© 2004 Microchip Technology Inc.

DS51471A-page 107



PICDEM.net™ 1 and dsPICDEM.net 2 Connectivity Dev Board User’s Guide

Push Button

RESEL....cceeeeeeeeeeeee e 91
Pushbutton Switches.............cccccooeiiiiiiiiiccies 10
R
Recommended Reading..........cccoevviivieeiiiiiee e, 3
Reference Documents..........ccoeeeeeeiieeiiiiiiiiicieeeeeeeees 1
Reset SWItCh ......eueiiiiiiee e 10
RJ-45 (10-Base T) Connector..........occcevevceeeeceeeenen. 9
RS-232 CoNNECtION ....cocveveeeeeeeeeeeeeee s 8
RS-422 ConNECtioN ......cocvvveeeeeeeeeeeeeeeeeeeceeeeees 8
RS-485 ConNecCtioN..........covviiiieeeeeeeeeeeeeeeee e 8
S
Serial EE MeMOTY ...ccoccvviiiiiiiiieeeiee e 10
Si3021 Reset SWItCh .......cvvveeeeiiiiiiiieeeeee e, 9
Si3034 DAA/AFE Chipset........cccoeeviieiiiieiiiee e 9
Si3035 DAA/AFE Chipset.......cccooeeiiiiiiiieeieeciieeee, 9

T
Temperature SEeNSOr .........cccoccuvieeeeeeiiieee e 88
Thermal Sensor (U12)....cccceeiieeiieeeeeee e 9
Troubleshooting

Web Server Demonstration.........ccccccceeeeeeeennn. 58
Tutorial ...coooeeeeeeee e 13, 31
U
UART T e 8
w
Warranty Registration..........c.ccccoviiiiiiiniiiiece, 2
Web Page

Web Server Demonstration............ccccceeeeeeeeee. 54
Web Server Demonstration

(07D I BT o] - 53

OVEIVIEW ...ttt 49

Web Page ... 54
WOrKSPACE ...ooeeiiiiiiiee e 13,32
WWW AAAIrESS ...t 4

DS51471A-page 108

© 2004 Microchip Technology Inc.



IndeXx

NOTES:

© 2004 Microchip Technology Inc. DS51471A-page 109



MICROCHIP

WORLDWIDE SALES AND SERVICE

AMERICAS

Corporate Office

2355 West Chandler Blvd.
Chandler, AZ 85224-6199

Tel: 480-792-7200

Fax: 480-792-7277

Technical Support: 480-792-7627
Web Address: www.microchip.com

Atlanta

3780 Mansell Road, Suite 130
Alpharetta, GA 30022

Tel: 770-640-0034

Fax: 770-640-0307

Boston

2 Lan Drive, Suite 120
Westford, MA 01886
Tel: 978-692-3848
Fax: 978-692-3821

Chicago

333 Pierce Road, Suite 180
Itasca, IL 60143

Tel: 630-285-0071

Fax: 630-285-0075

Dallas

4570 Westgrove Drive, Suite 160
Addison, TX 75001

Tel: 972-818-7423

Fax: 972-818-2924

Detroit

Tri-Atria Office Building

32255 Northwestern Highway, Suite 190
Farmington Hills, Ml 48334

Tel: 248-538-2250

Fax: 248-538-2260

Kokomo

2767 S. Albright Road
Kokomo, IN 46902
Tel: 765-864-8360
Fax: 765-864-8387

Los Angeles

18201 Von Karman, Suite 1090
Irvine, CA 92612

Tel: 949-263-1888

Fax: 949-263-1338

San Jose

1300 Terra Bella Avenue
Mountain View, CA 94043
Tel: 650-215-1444

Fax: 650-961-0286

Toronto

6285 Northam Drive, Suite 108
Mississauga, Ontario L4V 1X5, Canada
Tel: 905-673-0699

Fax: 905-673-6509

ASIA/PACIFIC

Australia

Suite 22, 41 Rawson Street
Epping 2121, NSW
Australia

Tel: 61-2-9868-6733

Fax: 61-2-9868-6755

China - Beijing

Unit 706B

Wan Tai Bei Hai Bldg.

No. 6 Chaoyangmen Bei Str.

Beijing, 100027, China

Tel: 86-10-85282100

Fax: 86-10-85282104

China - Chengdu

Rm. 2401-2402, 24th Floor,

Ming Xing Financial Tower

No. 88 TIDU Street

Chengdu 610016, China

Tel: 86-28-86766200

Fax: 86-28-86766599

China - Fuzhou

Unit 28F, World Trade Plaza

No. 71 Wusi Road

Fuzhou 350001, China

Tel: 86-591-7503506

Fax: 86-591-7503521

China - Hong Kong SAR

Unit 901-6, Tower 2, Metroplaza

223 Hing Fong Road

Kwai Fong, N.T., Hong Kong

Tel: 852-2401-1200

Fax: 852-2401-3431

China - Shanghai

Room 701, Bldg. B

Far East International Plaza

No. 317 Xian Xia Road

Shanghai, 200051

Tel: 86-21-6275-5700

Fax: 86-21-6275-5060

China - Shenzhen

Rm. 1812, 18/F, Building A, United Plaza
No. 5022 Binhe Road, Futian District
Shenzhen 518033, China

Tel: 86-755-82901380

Fax: 86-755-8295-1393

China - Shunde

Room 401, Hongjian Building, No. 2
Fengxiangnan Road, Ronggui Town, Shunde
District, Foshan City, Guangdong 528303, China
Tel: 86-757-28395507 Fax: 86-757-28395571
China - Qingdao

Rm. B505A, Fullhope Plaza,

No. 12 Hong Kong Central Rd.

Qingdao 266071, China

Tel: 86-532-5027355 Fax: 86-532-5027205
India

Divyasree Chambers

1 Floor, Wing A (A3/A4)

No. 11, O’'Shaugnessey Road
Bangalore, 560 025, India

Tel: 91-80-22290061 Fax: 91-80-22290062
Japan

Benex S-1 6F

3-18-20, Shinyokohama

Kohoku-Ku, Yokohama-shi

Kanagawa, 222-0033, Japan

Tel: 81-45-471- 6166 Fax: 81-45-471-6122

Korea

168-1, Youngbo Bldg. 3 Floor
Samsung-Dong, Kangnam-Ku

Seoul, Korea 135-882

Tel: 82-2-554-7200 Fax: 82-2-558-5932 or
82-2-558-5934

Singapore

200 Middle Road

#07-02 Prime Centre

Singapore, 188980

Tel: 65-6334-8870 Fax: 65-6334-8850
Taiwan

Kaohsiung Branch

30F - 1 No. 8

Min Chuan 2nd Road

Kaohsiung 806, Taiwan

Tel: 886-7-536-4818

Fax: 886-7-536-4803

Taiwan

Taiwan Branch

11F-3, No. 207

Tung Hua North Road

Taipei, 105, Taiwan

Tel: 886-2-2717-7175 Fax: 886-2-2545-0139

EUROPE

Austria

Durisolstrasse 2

A-4600 Wels

Austria

Tel: 43-7242-2244-399
Fax: 43-7242-2244-393
Denmark

Regus Business Centre
Lautrup hoj 1-3

Ballerup DK-2750 Denmark
Tel: 45-4420-9895 Fax: 45-4420-9910

France

Parc d’Activite du Moulin de Massy
43 Rue du Saule Trapu
Batiment A - ler Etage

91300 Massy, France

Tel: 33-1-69-53-63-20

Fax: 33-1-69-30-90-79
Germany

Steinheilstrasse 10

D-85737 Ismaning, Germany
Tel: 49-89-627-144-0

Fax: 49-89-627-144-44

Italy

Via Quasimodo, 12

20025 Legnano (MI)

Milan, Italy

Tel: 39-0331-742611

Fax: 39-0331-466781
Netherlands

P. A. De Biesbosch 14
NL-5152 SC Drunen, Netherlands
Tel: 31-416-690399

Fax: 31-416-690340

United Kingdom

505 Eskdale Road

Winnersh Triangle
Wokingham

Berkshire, England RG41 5TU
Tel: 44-118-921-5869

Fax: 44-118-921-5820

02/17/04

DS51471A-page 110

© 2004 Microchip Technology Inc.



Mouser Electronics

Authorized Distributor

Click to View Pricing, Inventory, Delivery & Lifecycle Information:

Microchip:
DM300004-1 DM300004-2



http://www.mouser.com/microchip
http://www.mouser.com/access/?pn=DM300004-1
http://www.mouser.com/access/?pn=DM300004-2

	Preface
	Chapter 1. Introduction
	1.1 Introduction
	1.2 Highlights
	1.3 Overview
	1.4 dsPICDEM.net Package Contents
	1.5 dsPICDEM.net Board Functionality
	1.6 dsPICDEM.net Demonstration Programs
	1.7 Reference Documents

	Chapter 2. Tutorial
	2.1 Introduction
	2.2 Highlights
	2.3 Tutorial Overview
	2.4 Creating the Project
	2.4.1 Select a Device
	2.4.2 Select Language Toolsuite
	2.4.3 Name Your Project
	2.4.4 Add Files to Project

	2.5 Building the Code
	2.5.1 Set Project Build Options
	2.5.2 Build the Project

	2.6 Device Configuration and Programming
	2.6.1 Set Up Device Configuration
	2.6.2 Enabling the MPLAB ICD 2 Connection

	2.7 Debugging the Code
	2.7.1 Display the Code
	2.7.2 Step the Program
	2.7.3 Set Breakpoint

	2.8 Summary

	Chapter 3. Quick Start Program
	3.1 Introduction
	3.2 Highlights
	3.3 Quick Start Program Overview
	3.4 Creating the Project
	3.4.1 Select a Device
	3.4.2 Select Language Toolsuite
	3.4.3 Name Your Project
	3.4.4 Add Files to Project

	3.5 Building the Code
	3.5.1 Set Project Build Options
	3.5.2 Build the Project

	3.6 Device Configuration and Programming
	3.6.1 Set Up Device Configuration
	3.6.2 Enabling the MPLAB ICD 2 Connection

	3.7 Interacting with the Code
	3.8 Quick Start Demonstration Features and Peripherals
	3.8.1 dsPIC30F Peripheral Features

	3.9 Data and Control Flow
	3.9.1 Power-up Sequence
	3.9.2 Main Loop Code Execution
	3.9.3 Interrupts Used in the Demonstration Program

	3.10 Summary

	Chapter 4. HTTP Web Server �Demonstration
	4.1 Introduction
	4.2 Highlights
	4.3 Demonstration Overview
	4.4 Demonstration Setup
	4.4.1 Equipment Requirements
	4.4.2 Equipment Setup
	4.4.3 WEB Server Program Setup

	4.5 Configuring your Laptop or Desktop PC
	4.6 HTTP Web Server Demonstration
	4.6.1 Programming the dsPIC30F6014 Device
	4.6.2 Start HTTP Web Server Session
	4.6.3 Monitor the dsPICDEM.net™ Development Board
	4.6.4 Control the dsPICDEM.net™ Development Board
	4.6.5 Hyper Text Transfer Protocol

	4.7 Debugging TIPS
	4.8 Troubleshooting
	4.9 Using HTTP Web Server in Your Application

	Chapter 5. FTP Server Demonstration
	5.1 Introduction
	5.1 Highlights
	5.2 Application Overview
	5.3 Demonstration Setup
	5.3.1 Equipment Requirements
	5.3.2 Equipment Setup
	5.3.3 FTP Server Program Setup

	5.4 Configuring your Laptop or Desktop PC
	5.4.1 Network Connections

	5.5 FTP Server Demonstration
	5.5.1 Programming the dsPIC30F6014 Device
	5.5.2 Start FTP Server Session
	5.5.3 Receive File From FTP Server
	5.5.4 Send a File to FTP Server

	5.6 Summary

	Chapter 6. V.22bis Soft Modem Demonstration
	6.1 Introduction
	6.1 Highlights
	6.2 Demonstration Overview
	6.3 Demonstration Configurations
	6.3.1 Equipment Requirements
	6.3.2 Selecting the Demonstration Configuration

	6.4 Demonstration Procedures
	6.4.1 Initialize the Hardware
	6.4.2 Configure the Terminal for dsPIC30F Soft Modem
	6.4.3 Initiate Communication

	6.5 Reprogramming the dsPIC30F6014
	6.6 Description of dsPIC30F Soft Modem
	6.7 dsPIC30F Soft Modem AT Command Set
	6.8 Troubleshooting the Connection
	6.8.1 Standard Reference Modems
	6.8.2 ITU-T V.8 Support
	6.8.3 Data Flow Control
	6.8.4 V.23 Connection Between dsPIC30F Soft Modem and US Robotics Modem
	6.8.5 V.21 connection Between dsPIC30F Soft Modem and US Robotics Modem
	6.8.6 Response Messages for Successful Modem Connections

	6.9 Regulatory Compliance Reference Information
	6.9.1 Federal Communications Commission
	6.9.2 Industry Canada DOC CS-03
	6.9.3 Common Technical Regulation CTR-21
	6.9.4 Japan Approval Institute for Telecommunications Equipment

	6.10 ITU-T Specifications

	Chapter 7. dsPICDEM.net Development Hardware
	7.1 dsPICDEM.net Hardware Components
	7.1.1 RS-232 Serial Port
	7.1.2 CAN Port
	7.1.3 RS-485/RS-422 Port
	7.1.4 Temperature Sensor
	7.1.5 Analog Potentiometers
	7.1.6 Push Button Switches
	7.1.7 LEDs
	7.1.8 Digital Potentiometer
	7.1.9 LCD Graphic Display
	7.1.10 ICD Connector
	7.1.11 Public-Switch Telephone Network (PSTN) Interface
	7.1.12 10-Base T Ethernet
	7.1.13 Serial EE Memory Device
	7.1.14 64k x 16 External SRAM
	7.1.15 Emulation Header
	7.1.16 Power Supply
	7.1.17 Power-on Indicator
	7.1.18 Oscillator
	7.1.19 Reset Switch
	7.1.20 Prototyping Area
	7.1.21 Sample Devices


	Appendix A. Hardware Schematics
	A.1 Board Layout and Schematics
	A.1.1 dsPICDEM.net 1 and dsPICDEM.net 2 Development Board

	Notes:

	Worldwide Sales and Service

